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Tech Support Business Plan Template & Guidebook
If you’re looking to start a successful tech support business, you’ve come to the right place! The #1 Tech Support Business Plan Template & Guidebook provides an easy-to-follow roadmap that outlines exactly what you need to do to create a professional and comprehensive plan. With insights and tips from leading industry professionals, this template and guidebook offers the tools and resources you need to put your tech support business on track for success.

Get worry-free services and support to launch your business starting at $0 plus state fees.
	How to Start a Profitable Tech Support Business [11 Steps]
	10+ Best & Profitable Tech Support Business Ideas [2023]


How to Write a Tech Support Business Plan in 7 Steps:
1. describe the purpose of your tech support business..
The first step to writing your business plan is to describe the purpose of your tech support business. This includes describing why you are starting this type of business, and what problems it will solve for customers. This is a quick way to get your mind thinking about the customers’ problems. It also helps you identify what makes your business different from others in its industry.
It also helps to include a vision statement so that readers can understand what type of company you want to build.
Here is an example of a purpose mission statement for a tech support business:
Our mission is to support clients by providing quality and reliable technical assistance, delivered with assurance and a commitment to excellence. We aim to provide cost-effective solutions to our clients’ technical needs, while cultivating long-term relationships of trust and dependability.

2. Products & Services Offered by Your Tech Support Business.
The next step is to outline your products and services for your tech support business. 
When you think about the products and services that you offer, it's helpful to ask yourself the following questions:
	What is my business?
	What are the products and/or services that I offer?
	Why am I offering these particular products and/or services?
	How do I differentiate myself from competitors with similar offerings?
	How will I market my products and services?

You may want to do a comparison of your business plan against those of other competitors in the area, or even with online reviews. This way, you can find out what people like about them and what they don’t like, so that you can either improve upon their offerings or avoid doing so altogether.

3. Build a Creative Marketing Stratgey.
If you don't have a marketing plan for your tech support business, it's time to write one. Your marketing plan should be part of your business plan and be a roadmap to your goals. 
A good marketing plan for your tech support business includes the following elements:
Target market
	Who is your target market?
	What do these customers have in common?
	How many of them are there?
	How can you best reach them with your message or product?

Customer base 
	Who are your current customers? 
	Where did they come from (i.e., referrals)?
	How can their experience with your tech support business help make them repeat customers, consumers, visitors, subscribers, or advocates for other people in their network or industry who might also benefit from using this service, product, or brand?

Product or service description
	How does it work, what features does it have, and what are its benefits?
	Can anyone use this product or service regardless of age or gender?
	Can anyone visually see themselves using this product or service?
	How will they feel when they do so? If so, how long will the feeling last after purchasing (or trying) the product/service for the first time?

Competitive analysis
	Which companies are competing with yours today (and why)? 
	Which ones may enter into competition with yours tomorrow if they find out about it now through word-of-mouth advertising; social media networks; friends' recommendations; etc.)
	What specific advantages does each competitor offer over yours currently?

Marketing channels
	Which marketing channel do you intend to leverage to attract new customers?
	What is your estimated marketing budget needed?
	What is the projected cost to acquire a new customer?
	How many of your customers do you instead will return?

Form an LLC in your state!

4. Write Your Operational Plan.
Next, you'll need to build your operational plan. This section describes the type of business you'll be running, and includes the steps involved in your operations. 
In it, you should list:
	The equipment and facilities needed
	Who will be involved in the business (employees, contractors)
	Financial requirements for each step
	Milestones & KPIs
	Location of your business
	Zoning & permits required for the business

What equipment, supplies, or permits are needed to run a tech support business?
	Technical knowledge and expertise
	Business license or permit
	Computer hardware and software
	Internet connection
	Phone line/Internet connection
	Printer/scanner/fax machine
	Customer service skills and training materials
	Office supplies such as pens, paper, and file folders.

5. Management & Organization of Your Tech Support Business.
The second part of your tech support business plan is to develop a management and organization section.
This section will cover all of the following:
	How many employees you need in order to run your tech support business. This should include the roles they will play (for example, one person may be responsible for managing administrative duties while another might be in charge of customer service).
	The structure of your management team. The higher-ups like yourself should be able to delegate tasks through lower-level managers who are directly responsible for their given department (inventory and sales, etc.).
	How you’re going to make sure that everyone on board is doing their job well. You’ll want check-ins with employees regularly so they have time to ask questions or voice concerns if needed; this also gives you time to offer support where necessary while staying informed on how things are going within individual departments too!

6. Tech Support Business Startup Expenses & Captial Needed.
This section should be broken down by month and year. If you are still in the planning stage of your business, it may be helpful to estimate how much money will be needed each month until you reach profitability.
Typically, expenses for your business can be broken into a few basic categories:
Startup Costs
Startup costs are typically the first expenses you will incur when beginning an enterprise. These include legal fees, accounting expenses, and other costs associated with getting your business off the ground. The amount of money needed to start a tech support business varies based on many different variables, but below are a few different types of startup costs for a tech support business.
Running & Operating Costs
Running costs refer to ongoing expenses related directly with operating your business over time like electricity bills or salaries paid out each month. These types of expenses will vary greatly depending on multiple variables such as location, team size, utility costs, etc.
Marketing & Sales Expenses
You should include any costs associated with marketing and sales, such as advertising and promotions, website design or maintenance. Also, consider any additional expenses that may be incurred if you decide to launch a new product or service line. For example, if your tech support business has an existing website that needs an upgrade in order to sell more products or services, then this should be listed here.
7. Financial Plan & Projections
A financial plan is an important part of any business plan, as it outlines how the business will generate revenue and profit, and how it will use that profit to grow and sustain itself. To devise a financial plan for your tech support business, you will need to consider a number of factors, including your start-up costs, operating costs, projected revenue, and expenses. 
Here are some steps you can follow to devise a financial plan for your tech support business plan:
	Determine your start-up costs: This will include the cost of purchasing or leasing the space where you will operate your business, as well as the cost of buying or leasing any equipment or supplies that you need to start the business.
	Estimate your operating costs: Operating costs will include utilities, such as electricity, gas, and water, as well as labor costs for employees, if any, and the cost of purchasing any materials or supplies that you will need to run your business.
	Project your revenue: To project your revenue, you will need to consider the number of customers you expect to have and the average amount they will spend on each visit. You can use this information to estimate how much money you will make from selling your products or services.
	Estimate your expenses: In addition to your operating costs, you will need to consider other expenses, such as insurance, marketing, and maintenance. You will also need to set aside money for taxes and other fees.
	Create a budget: Once you have estimated your start-up costs, operating costs, revenue, and expenses, you can use this information to create a budget for your business. This will help you to see how much money you will need to start the business, and how much profit you can expect to make.
	Develop a plan for using your profit: Finally, you will need to decide how you will use your profit to grow and sustain your business. This might include investing in new equipment, expanding the business, or saving for a rainy day.


Frequently Asked Questions About Tech Support Business Plans:
Why do you need a business plan for a tech support business.
A business plan is an important tool for a tech support business, as it allows the business owners to set goals and objectives, as well as gain insights into potential challenges and opportunities. By having a clear plan of action, the business owners can ensure that their operations are successful and efficient. A business plan can also help secure necessary funding and build credibility with potential investors.
Who should you ask for help with your tech support business plan?
Depending on the specifics of the tech support business plan, you may want to reach out to a variety of professionals such as a lawyer, accountant, business consultant, banker, or small business advisor for guidance.
Can you write a tech support business plan yourself?
Yes, it is possible to write a tech support business plan yourself. However, it can be a complex process and you may want to consider enlisting the help of a professional business consultant, who can provide invaluable guidance in structuring your plan and developing a winning strategy.
Related Business Plans

Home Inventory Business Plan Template & Guidebook

Home Inspection Business Plan Template & Guidebook

Home Decor Business Plan Template & Guidebook

Health And Wellness Business Plan Template & Guidebook

Hauling Business Plan Template & Guidebook

Hardware Business Plan Template & Guidebook

Handyman Business Plan Template & Guidebook

Hair Extension Business Plan Template & Guidebook

Handbag Business Plan Template & Guidebook
I'm Nick, co-founder of newfoundr.com, dedicated to helping aspiring entrepreneurs succeed. As a small business owner with over five years of experience, I have garnered valuable knowledge and insights across a diverse range of industries. My passion for entrepreneurship drives me to share my expertise with aspiring entrepreneurs, empowering them to turn their business dreams into reality.
Through meticulous research and firsthand experience, I uncover the essential steps, software, tools, and costs associated with launching and maintaining a successful business. By demystifying the complexities of entrepreneurship, I provide the guidance and support needed for others to embark on their journey with confidence.
From assessing market viability and formulating business plans to selecting the right technology and navigating the financial landscape, I am dedicated to helping fellow entrepreneurs overcome challenges and unlock their full potential. As a steadfast advocate for small business success, my mission is to pave the way for a new generation of innovative and driven entrepreneurs who are ready to make their mark on the world.

Technology Business Plan Template
Written by Dave Lavinsky

Over the past 20+ years, we have helped over 1,000 entrepreneurs and business owners create business plans to start and grow their technology businesses. On this page, we will first give you some background information with regards to the importance of business planning. We will then go through a technology business plan template step-by-step so you can create your plan today.
Download our Ultimate Business Plan Template here >
What Is a Business Plan?
A business plan provides a snapshot of your technology business as it stands today, and lays out your growth plan for the next five years. It explains your business goals and your strategy for reaching them. It also includes market research to support your plans.
Why You Need a Business Plan
If you’re looking to start a technology business, or grow your existing technology business, you need a business plan. A business plan will help you raise funding, if needed, and plan out the growth of your technology business in order to improve your chances of success. Your technology business plan is a living document that should be updated annually as your company grows and changes.
Sources of Funding for Technology Businesses
With regards to funding, the main sources of funding for a technology business are personal savings, credit cards, bank loans and angel investors. With regards to bank loans, banks will want to review your business plan and gain confidence that you will be able to repay your loan and interest. To acquire this confidence, the loan officer will not only want to confirm that your financials are reasonable, but they will also want to see a professional plan. Such a plan will give them the confidence that you can successfully and professionally operate a business. Personal savings and bank loans are the most common funding paths for technology businesses.
Finish Your Business Plan Today!
If you want to start a technology business or expand your current one, you need a business plan. Below are links to each section of your technology business plan template:
Executive Summary
Your executive summary provides an introduction to your business plan, but it is normally the last section you write because it provides a summary of each key section of your plan.
The goal of your Executive Summary is to quickly engage the reader. Explain to them the type of technology business you are operating and the status. For example, are you a startup, do you have a technology business that you would like to grow, or are you operating technology businesses in multiple markets?
Next, provide an overview of each of the subsequent sections of your plan. For example, give a brief overview of the technology industry. Discuss the type of technology business you are operating. Detail your direct competitors. Give an overview of your target customers. Provide a snapshot of your marketing plan. Identify the key members of your team. And offer an overview of your financial plan.  
Company Analysis
In your company analysis, you will detail the type of technology business you are operating.
For example, you might operate one of the following types of technology businesses:
	Network technology : this type of technology company specializes in providing the computers, printers, scanners, and phones within an organization and making sure they are all linked together in order to work seamlessly with one another.
	Software technology: this type of technology company specializes in providing and/or installing the appropriate software needed for the business. This will include the programs and productivity tools for the organization’s computer network.
	Customer relationship technology: this type of technology company focuses on providing a customer relationship management system (CRM) that keeps track of all customer interactions and information in order to consistently provide exceptional customer service.

In addition to explaining the type of technology business you will operate, the Company Analysis section of your business plan needs to provide background on the business.
Include answers to question such as:
	When and why did you start the business?
	What milestones have you achieved to date? Milestones could include the number of client companies served, number of positive reviews, reaching X amount of client companies served, etc.
	Your legal structure. Are you incorporated as an S-Corp? An LLC? A sole proprietorship? Explain your legal structure here.

Industry Analysis
In your industry analysis, you need to provide an overview of the technology industry.
While this may seem unnecessary, it serves multiple purposes.
First, researching the technology industry educates you. It helps you understand the market in which you are operating. 
Secondly, market research can improve your strategy, particularly if your research identifies market trends.
The third reason for market research is to prove to readers that you are an expert in your industry. By conducting the research and presenting it in your plan, you achieve just that.
The following questions should be answered in the industry analysis section of your technology business plan:
	How big is the technology industry (in dollars)?
	Is the market declining or increasing?
	Who are the key competitors in the market?
	Who are the key suppliers in the market?
	What trends are affecting the industry?
	What is the industry’s growth forecast over the next 5 – 10 years?
	What is the relevant market size? That is, how big is the potential market for your technology business? You can extrapolate such a figure by assessing the size of the market in the entire country and then applying that figure to your local population.

Customer Analysis
The customer analysis section of your technology business plan must detail the customers you serve and/or expect to serve.
The following are examples of customer segments: individuals, small businesses, and local companies that need technological services.
As you can imagine, the customer segment(s) you choose will have a great impact on the type of technology business you operate. Clearly, large companies would respond to different marketing promotions than small businesses, for example.
Try to break out your target customers in terms of their demographic and psychographic profiles. With regards to demographics, include a discussion of the ages, genders, locations and income levels of the customers you seek to serve.
Psychographic profiles explain the wants and needs of your target customers. The more you can understand and define these needs, the better you will do in attracting and retaining your customers.
Finish Your Technology Business Plan in 1 Day!
Don’t you wish there was a faster, easier way to finish your business plan?
With Growthink’s Ultimate Business Plan Template you can finish your plan in just 8 hours or less!
Competitive Analysis
Your competitive analysis should identify the indirect and direct competitors your business faces and then focus on the latter.
Direct competitors are other technology companies. 
Indirect competitors are other options that customers have to purchase from that aren’t direct competitors. This includes technology companies such as Geek Squad, local stores that sell and rehab tech equipment, online technology companies, etc.
With regards to direct competition, you want to describe the other technology businesses with which you compete. Most likely, your direct competitors will be technology businesses located very close to your location.
For each such competitor, provide an overview of their businesses and document their strengths and weaknesses. Unless you once worked at your competitors’ businesses, it will be impossible to know everything about them. But you should be able to find out key things about them such as:
	What types of technology do they provide?
	What areas do they serve?
	What type of technology company are they?
	What is their pricing (premium, low, etc.)?
	What are they good at?
	What are their weaknesses?

With regards to the last two questions, think about your answers from the customers’ perspective. And don’t be afraid to ask your competitors’ customers what they like most and least about them.
The final part of your competitive analysis section is to document your areas of competitive advantage. For example:
	Is your technology business more capable than the competition?
	Will you provide technology services that your competitors don’t offer?
	Will you provide faster technology service?
	Will you provide better customer service?
	Will you offer better pricing?

Think about ways you will outperform your competition and document them in this section of your plan.  
Marketing Plan
Traditionally, a marketing plan includes the four P’s: Product, Price, Place, and Promotion. For a technology business plan, your marketing plan should include the following:
Product : In the product section, you should reiterate the type of technology company that you documented in your Company Analysis. Then, detail the specific products you will be offering. For example, in addition to technology services, will you provide computer repair, 24/7/365 service, phone installation, and any other services?
Price : Document the prices you will offer and how they compare to your competitors. Essentially in the product and price sub-sections of your marketing plan, you are presenting the services you offer and their prices.
Place : Place refers to the location of your technology company. Document your location and mention how the location will impact your success. For example, is your technology business located near an office complex, an urban setting, or a busy neighborhood, etc. Discuss how your location might be the ideal location for your customers.
Promotions : The final part of your technology marketing plan is the promotions section. Here you will document how you will drive customers to your location(s). The following are some promotional methods you might consider:
	Website and SEO marketing
	Commercials
	Social media marketing
	Local radio advertising
	Business networking

Operations Plan
While the earlier sections of your business plan explained your goals, your operations plan describes how you will meet them. Your operations plan should have two distinct sections as follows.
Everyday short-term processes include all of the tasks involved in running your technology business, including updating technology, client communication and scheduling, marketing, and implementing and installing the new technology for a client.
Long-term goals are the milestones you hope to achieve. These could include the dates when you expect to obtain your XXth client company, or when you hope to reach $X in revenue. It could also be when you expect to expand your technology business to a new location.  
Management Team
To demonstrate your technology business’ ability to succeed, a strong management team is essential. Highlight your key players’ backgrounds, emphasizing those skills and experiences that prove their ability to grow a company. 
Ideally you and/or your team members have direct experience in managing technologys. If so, highlight this experience and expertise. But also highlight any experience that you think will help your business succeed.
If your team is lacking, consider assembling an advisory board. An advisory board would include 2 to 8 individuals who would act like mentors to your business. They would help answer questions and provide strategic guidance. If needed, look for advisory board members with experience in managing a technology business or are connected to a wide network of professional organizations that frequently utilize technology.  
Financial Plan
Your financial plan should include your 5-year financial statement broken out both monthly or quarterly for the first year and then annually. Your financial statements include your income statement, balance sheet and cash flow statements.
Income Statement : an income statement is more commonly called a Profit and Loss statement or P&L. It shows your revenues and then subtracts your costs to show whether you turned a profit or not.
In developing your income statement, you need to devise assumptions. For example, will you take on one new client company at a time or multiple new client companies ? And will sales grow by 2% or 10% per year? As you can imagine, your choice of assumptions will greatly impact the financial forecasts for your business. As much as possible, conduct research to try to root your assumptions in reality.
Balance Sheets : Balance sheets show your assets and liabilities. While balance sheets can include much information, try to simplify them to the key items you need to know about. For instance, if you spend $50,000 on building out your technology business, this will not give you immediate profits. Rather it is an asset that will hopefully help you generate profits for years to come. Likewise, if a bank writes you a check for $50,000, you don’t need to pay it back immediately. Rather, that is a liability you will pay back over time.
Cash Flow Statement : Your cash flow statement will help determine how much money you need to start or grow your business, and make sure you never run out of money. What most entrepreneurs and business owners don’t realize is that you can turn a profit but run out of money and go bankrupt. 
In developing your Income Statement and Balance Sheets be sure to include several of the key costs needed in starting or growing a technology business:
	Cost of technology to be installed
	Cost of software and equipment
	Payroll or salaries paid to staff
	Business insurance
	Taxes and permits
	Legal expenses

Attach your full financial projections in the appendix of your plan along with any supporting documents that make your plan more compelling. For example, you might include your list of technology services, types of clients you will be targeting, and the areas your technology business will serve.  
Putting together a business plan for your technology business is a worthwhile endeavor. If you follow the template above, by the time you are done, you will truly be an expert. You will really understand the technology industry, your competition, and your customers. You will have developed a marketing plan and will really understand what it takes to launch and grow a successful technology business.  
Technology Business Plan FAQs
What is the easiest way to complete my technology business plan.
Growthink's Ultimate Business Plan Template allows you to quickly and easily complete your Technology Business Plan.
What is the Goal of a Business Plan's Executive Summary?
The goal of your Executive Summary is to quickly engage the reader. Explain to them the type of technology business you are operating and the status; for example, are you a startup, do you have a technology business that you would like to grow, or are you operating a chain of technology businesses?
Don’t you wish there was a faster, easier way to finish your Technology business plan?
OR, Let Us Develop Your Plan For You
Since 1999, Growthink has developed business plans for thousands of companies who have gone on to achieve tremendous success.   Click here to see how a Growthink business planning advisor can create your business plan for you.
Other Helpful Business Plan Articles & Templates
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Link copied
We’ve gathered the most useful collection of business plan PDF templates and samples, including options for organizations of any size and type.
On this page, you’ll find free PDF templates for a simple business plan , small business plan , startup business plan , and more.
Simple Business Plan PDF Templates
These simple business plan PDF templates are ready to use and customizable to fit the needs of any organization.
Simple Business Plan Template PDF

This template contains a traditional business plan layout to help you map out each aspect, from a company overview to sales projections and a marketing strategy. This template includes a table of contents, as well as space for financing details that startups looking for funding may need to provide. 
Download Simple Business Plan Template - PDF
Lean Business Plan Template PDF

This scannable business plan template allows you to easily identify the most important elements of your plan. Use this template to outline key details pertaining to your business and industry, product or service offerings, target customer segments (and channels to reach them), and to identify sources of revenue. There is also space to include key performance metrics and a timeline of activities. 
Download Lean Business Plan Template - PDF
Simple 30-60-90 Day Business Plan Template PDF

This template is designed to help you develop and implement a 90-day business plan by breaking it down into manageable chunks of time. Use the space provided to detail your main goals and deliverables for each timeframe, and then add the steps necessary to achieve your objectives. Assign task ownership and enter deadlines to ensure your plan stays on track every step of the way.
Download Simple 30-60-90 Day Business Plan Template
PDF | Smartsheet
One-Page Business Plan PDF Templates
The following single page business plan templates are designed to help you download your key ideas on paper, and can be used to create a pitch document to gain buy-in from partners, investors, and stakeholders.
One-Page Business Plan Template PDF

Use this one-page template to summarize each aspect of your business concept in a clear and concise manner. Define the who, what, why, and how of your idea, and use the space at the bottom to create a SWOT analysis (strengths, weaknesses, opportunities, and threats) for your business. 
Download One-Page Business Plan Template
If you’re looking for a specific type of analysis, check out our collection of SWOT templates .
One-Page Lean Business Plan PDF

This one-page business plan template employs the Lean management concept, and encourages you to focus on the key assumptions of your business idea. A Lean plan is not stagnant, so update it as goals and objectives change — the visual timeline at the bottom is ideal for detailing milestones. 
Download One-Page Lean Business Plan Template - PDF
One-Page 30-60-90 Day Business Plan Template

Use this business plan template to identify main goals and outline the necessary activities to achieve those goals in 30, 60, and 90-day increments. Easily customize this template to fit your needs while you track the status of each task and goal to keep your business plan on target. 
Download One-Page 30-60-90 Day Business Plan Template
For additional single page plans, including an example of a one-page business plan , visit " One-Page Business Plan Templates with a Quick How-To Guide ."
Small Business Plan PDF Templates
These business plan templates are useful for small businesses that want to map out a way to meet organizational objectives, including how to structure, operate, and expand their business.
Simple Small Business Plan Template PDF

A small business can use this template to outline each critical component of a business plan. There is space to provide details about product or service offerings, target audience, customer reach strategy, competitive advantage, and more. Plus, there is space at the bottom of the document to include a SWOT analysis. Once complete, you can use the template as a basis to build out a more elaborate plan. 
Download Simple Small Business Plan Template
Fill-In-the-Blank Small Business Plan Template PDF

This fill-in-the-blank template walks you through each section of a business plan. Build upon the fill-in-the-blank content provided in each section to add information about your company, business idea, market analysis, implementation plan, timeline of milestones, and much more.
Download Fill-In-the-Blank Small Business Plan Template - PDF
One-Page Small Business Plan Template PDF

Use this one-page template to create a scannable business plan that highlights the most essential parts of your organization’s strategy. Provide your business overview and management team details at the top, and then outline the target market, market size, competitive offerings, key objectives and success metrics, financial plan, and more.
Download One-Page Business Plan for Small Business - PDF
Startup Business Plan PDF Templates
Startups can use these business plan templates to check the feasibility of their idea, and articulate their vision to potential investors.
Startup Business Plan Template

Use this business plan template to organize and prepare each essential component of your startup plan. Outline key details relevant to your concept and organization, including your mission and vision statement, product or services offered, pricing structure, marketing strategy, financial plan, and more.
Download Startup Business Plan Template
Sample 30-60-90 Day Business Plan for Startup

Startups can use this sample 30-60-90 day plan to establish main goals and deliverables spanning a 90-day period. Customize the sample goals, deliverables, and activities provided on this template according to the needs of your business. Then, assign task owners and set due dates to help ensure your 90-day plan stays on track.
Download Sample 30-60-90 Day Business Plan for Startup Template 
For additional resources to create your plan, visit “ Free Startup Business Plan Templates and Examples .”
Nonprofit Business Plan PDF Templates
Use these business plan PDF templates to outline your organization’s mission, your plan to make a positive impact in your community, and the steps you will take to achieve your nonprofit’s goals.
Nonprofit Business Plan Template PDF

Use this customizable PDF template to develop a plan that details your organization’s purpose, objectives, and strategy. This template features a table of contents, with room to include your nonprofit’s mission and vision, key team and board members, program offerings, a market and industry analysis, promotional plan, financial plan, and more. This template also contains a visual timeline to display historic and future milestones.
Download Nonprofit Business Plan Template - PDF
One-Page Business Plan for Nonprofit Organization PDF 

This one-page plan serves as a good starting point for established and startup nonprofit organizations to jot down their fundamental goals and objectives. This template contains all the essential aspects of a business plan in a concise and scannable format, including the organizational overview, purpose, promotional plan, key objectives and success metrics, fundraising goals, and more.
Download One-Page Business Plan for Nonprofit Organization Template - PDF
Fill-In-the-Blank Business Plan PDF Templates
Use these fill-in-the-blank templates as a foundation for creating a comprehensive roadmap that aligns your business strategy with your marketing, sales, and financial goals.
Simple Fill-In-the-Blank Business Plan PDF
The fill-in-the-blank template contains all the vital parts of a business plan, with sample content that you can customize to fit your needs. There is room to include an executive summary, business description, market analysis, marketing plan, operations plan, financial statements, and more. 
Download Simple Fill-In-the-Blank Business Plan Template - PDF
Lean Fill-In-the-Blank Business Plan PDF

This business plan is designed with a Lean approach that encourages you to clarify and communicate your business idea in a clear and concise manner. This single page fill-in-the-blank template includes space to provide details about your management team, the problem you're solving, the solution, target customers, cost structure, and revenue streams. Use the timeline at the bottom to produce a visual illustration of key milestones. 
Download Fill-In-the-Blank Lean Business Plan Template - PDF
For additional resources, take a look at " Free Fill-In-the-Blank Business Plan Templates ."
Sample Business Plan PDF Templates
These sample business plan PDF templates can help you to develop an organized, thorough, and professional business plan.
Business Plan Sample 

This business plan example demonstrates a plan for a fictional food truck company. The sample includes all of the elements in a traditional business plan, which makes it a useful starting point for developing a plan specific to your business needs.
Download Basic Business Plan Sample - PDF
Sample Business Plan Outline Template

Use this sample outline as a starting point for your business plan. Shorten or expand the outline depending on your organization’s needs, and use it to develop a table of contents for your finalized plan.
Download Sample Business Plan Outline Template - PDF
Sample Business Financial Plan Template

Use this sample template to develop the financial portion of your business plan. The template provides space to include a financial overview, key assumptions, financial indicators, and business ratios. Complete the break-even analysis and add your financial statements to help prove the viability of your organization’s business plan.
Download Business Financial Plan Template
PDF  | Smartsheet
For more free, downloadable templates for all aspects of your business, check out “ Free Business Templates for Organizations of All Sizes .”
Improve Business Planning with Real-Time Work Management in Smartsheet
Empower your people to go above and beyond with a flexible platform designed to match the needs of your team — and adapt as those needs change. 
The Smartsheet platform makes it easy to plan, capture, manage, and report on work from anywhere, helping your team be more effective and get more done. Report on key metrics and get real-time visibility into work as it happens with roll-up reports, dashboards, and automated workflows built to keep your team connected and informed. 
When teams have clarity into the work getting done, there’s no telling how much more they can accomplish in the same amount of time.  Try Smartsheet for free, today.
Discover why over 90% of Fortune 100 companies trust Smartsheet to get work done.

Remote Tech Support Business Plan [Sample Template]
By: Author Tony Martins Ajaero
Home » Business Plans » Technology Sector

Are you about starting a tech support company? If YES, here is a detailed sample remote tech support business plan template & feasibility report you can use for FREE .
In today’s world, computers are a standard part of every family and a major tool used by businesses. But the majority of the people have little to no knowledge when it comes to fixing these gadgets when an issue arises. That is why tech support businesses offer support to consumers on an as-needed basis.
Large and small ventures leverage the services of tech support companies to provide ongoing maintenance as part of their preventative maintenance strategy.
Their services include: installation and maintenance of equipment, software installation, system networking, system auditing, troubleshooting, repair and training. As a Tech support entrepreneur, most of your days will be spent troubleshooting and fixing your client’s computer and software issues.
What this entails vary depending upon the services you offer and the services your client needs. Additionally, you will need to spend five to ten hours each week networking and marketing and taking care of any other administrative duties that need your attention.
When starting this business, it will be wrong to classify your target market as “anyone that has a computer issue.” This is too vast.
Define your target customer based on your skills and experience, as well as what is needed in your area. Since residential clients are often on a tighter budget, consider targeting small businesses. Many tech support business owners have found success focusing on remote tech support.
Tech support companies make revenue from the services they offer, including management of servers, computers, and networks. Clients are billed by the hour. Recent report has it that the computer services industry generates more than $47 billion annually.
The employees you hire and your team’s education and background are, ultimately, what will define your organization’s long-term success. Also note that professional training and certification is vital to your success. A+ certification and Network + certification are both highly recommended.
Having strong computer skills, however, is only part of the equation. You should also have the ability to communicate with clients and possess the interpersonal and leadership skills required to network, market, and manage a business.
A Sample Remote Tech Support Business Plan Template
1. industry overview.
Information Technology (IT) services are sometimes seen as an all-encompassing range of services, including computer programming, custom software design, hardware and software consulting, integrated systems design, training in software and hardware, systems management, and modifications of custom software.
Just like every other sector in the computer service industry, companies finding that they need one or all of these complex tasks often choose to hire an outside IT company rather than hire specialists in-house.
Industry reports have it that service providers in the industry compete not only with one another, but with manufacturers and retailers as well. Although IT service providers choose to serve a company’s entire bevy of needs, companies will frequently sign multiple providers for different services.
One factor that is becoming very popular for service providers is the “turn-key” system where an IT company negotiates to provide all the computer and software setup for a company as well as training, maintenance and continuing repair. Increasing wage costs have led to worries about profit margins in the industry getting tighter.
According to industry experts, there has also been a major push towards outsourcing, especially to india. One recent report estimated that 43% of US companies outsource at least some of their IT function. Internet service providers can also be said to be part of this industry as they provide internet access to businesses and individuals.
Far more than any of the other sectors, the ISP field is dominated by large companies. High speed internet, which consists of cable and DSL primarily, and newer technologies such as WiMax and FiOS, is dominant, replacing the earlier dial up connections which were prevalent in the 1990s.
The united states has 280m internet users as of 2015 – nearly 87% penetration. Nearly 90mm of those are broadband users.
Generally, computer service is a massive industry containing a number of different subfields. As computers continue to dominate our lives, there is more of a need than ever before for computer professionals. Because computers are always changing, that need should only increase as time goes forward.
2. Executive Summary
Eric Pearson® Remote Tech Support, Inc. is a remote technology and computer support firm registered and located in Seattle, Washington. We intend to serve corporate, customer-focused computer support companies. We plan to focus our service and support to differentiate our firm from more price-oriented computer support companies.
Computers and other technological gadgets are a standard part of our society and a major tool used by most businesses today. But even with the growing need and demand, most people have little to no knowledge when it comes to fixing these gadgets and most businesses cannot afford an in-house tech support department.
That is why we at Eric Pearson® Remote Tech Support, Inc. offer support for corporate individuals and businesses on an as-needed basis. We also believe that the current trend towards an increase in the number of entrepreneurs and competition amongst existing companies presents an opportunity for us to penetrate this market.
We understand that, for us to prosper, we need to be flexible and responsive, to delight clients by providing them with what they want, when they want it, and before the competition can offer it. One of our key objectives is to achieve this through a solutions approach that is customer-centric, and in which the customer’s business objectives enjoy top priority.
Immediately the needs and processes are understood and described, leading edge products and best-of-industry skills will be applied to develop a fitting solution in the most cost effective way.
Seattle’s economy is driven by a mix of older industrial companies, and “new economy” Internet and technology companies. Also, with Seattle being one of the fastest-growing U.S. city, with a 3.1% annual growth rate, it presents us with a viable market.
Our marketing strategy at Eric Pearson® Remote Tech Support, Inc. will ensure our clients know what need we are able to fulfill, and making the right service available to the market. We intend to implement a market penetration strategy that will ensure that our services are well recognized and respected in our industry.
We hope to ensure that our promotional strategy involves traditional advertising, Internet marketing, personal selling, public relations, and direct marketing, details of which are provided in the marketing section of this plan. Our intangible resources, such as our ability to relate to customers, our management style, corporate culture and commitment will go a long way to boost our brand.
We believe that these elements will differentiate us from our competitors and propel us towards the development of a sustainable brand. Our plan is not just to market and sell our product and services, but to provide customized services and products that will enable our clients to optimize their output and, assist in the attainment of their goals and objectives.
3. Our Products and Services
Our aim at Eric Pearson® Remote Tech Support, Inc. is to provide technological products and services to corporate and small businesses.
We will also provide wireless network systems and services and also design and install computer and technological gadgets, offer training, and support. In putting our business together, we have attempted to offer viable services to allow us to always be in demand.
4. Our Mission and Vision Statement
	Our vision at Eric Pearson® Remote Tech Support, Inc. is to serve our clients as trusted allies, providing them with the loyalty of a business partner and the economics of an outside vendor.
	Our mission at Eric Pearson® Remote Tech Support, Inc. is to be an established corporate firm that fulfills its obligations as a critical part of society. We believe that all our business decisions will offer appropriate weight and consideration to social and environmental impacts.

Our Business Structure
Eric Pearson® Remote Tech Support, Inc. understands that human resource element is a very crucial component in the delivery of service.
We believe that by rounding up enthusiastic, capable, and empowered people, we can be able to meet our clients’ needs. We hope to provide our teams enough leverage in decision-making to ensure that clients are handled promptly and to reduce lead-time in service delivery.
Our management philosophy at Eric Pearson® Remote Tech Support, Inc. will be based on responsibility and mutual respect.
We also appreciate the need to be constantly changing so as to adapt to the ever competitive environment. We will have a flexible structure allowing for all business processes to be undertaken swiftly and smoothly. We at Eric Pearson® Remote Tech Support, Inc. plan to start with the following business structure;
Chief Executive Officer
Technical Director
	Marketing and Advertisements manager

Human Resources and Admin Manager
	Sales and Marketing manager

Content designer and technical head
Client Service Executive
5. Job Roles and Responsibilities
	Tasked with building the firm’s effectiveness by recruiting, selecting, orienting, training, coaching, counselling, and disciplining managers; communicating values, strategies, and objectives; assigning accountabilities; planning, monitoring, and appraising job results
	Tasked with providing direction for the business
	Will also be tasked with creating, communicating, and implementing the organization’s vision, mission, and overall direction – i.e. leading the development and implementation of the overall organization’s strategy.
	Tasked with signing checks and documents on behalf of the company
	Evaluates the success of the organization
	Works as the project manager of the organization; works directly with employees
	Tasked with designing advert concepts and winning business proposals for the organization
	Tasked with developing strategic plan by studying technological and financial opportunities; presenting assumptions; recommending objectives.
	Tasked with accomplishing subsidiary objectives by establishing plans, budgets, and results measurements; allocating resources; reviewing progress; making mid-course corrections.
	Should be able to coordinate efforts by establishing procurement, production, marketing, field, and technical services policies and practices; coordinating actions with corporate staff.
	Tasked with building company image by collaborating with customers, government, community organizations, and employees; enforcing ethical business practices.
	Obligated to maintain quality service by establishing and enforcing organization standards.
	Tasked with maintaining professional and technical knowledge by attending educational workshops; reviewing professional publications; establishing personal networks; benchmarking state-of-the-art practices; participating in professional societies.
	Makes certain that operations and marketing department perform efficiently, coordinate employee efforts, and facilitate communications between management and employees
	Tasked with making sure that the organization work in line with international best practices.

Marketing and Advertisement manager
	Tasked with handling media planning, buying & representation
	Tasked with creating advertising campaigns
	Tasked with disseminating advertising campaigns through available mediums, such as TV, Radio and periodicals et al
	Tasked with handling core digital services such as brand affinity, banner advertising, video advertising, rich media advertising, sponsorship advertising, classifieds/directories, lead generation, mobile messaging/email, digital display advertising, mobile advertising, social media management
	Handle other related media and advertising advisory and consulting services
	Tasked with overseeing the smooth running of HR and administrative tasks for the organization
	Will have to define job positions for recruitment and managing interviewing process
	Tasked with carrying out staff induction for new team members
	Tasked with training, evaluation and assessment of employees
	Oversee the smooth running of the daily office.

Sales and Marketing Manager
	Tasked with managing external research and coordinate all the internal sources of information to retain the organizations’ best customers and attract new ones
	Obligated to model demographic information and analyze the volumes of transactional data generated by customer
	Should be able to identify development opportunities; follows up on development leads and contacts
	Writing winning proposal documents, negotiate fees and rates in line with organizations’ policy
	Tasked with handling business research, market surveys and feasibility studies for clients
	Tasked with supervising implementation, advocate for the customer’s needs, and communicate with clients
	Create new markets cum businesses for the organization
	Empower and motivates the sales team to meet and surpass agreed targets
	Tasked with preparing financial reports, budgets, and financial statements for the organization
	Tasked with providing the Companies management with financial analyses, development budgets, and accounting report
	Tasked with financial forecasting and risks analysis.
	Should be able to perform cash management, general ledger accounting, and financial reporting for one or more properties.
	Tasked with developing and managing financial systems and policies
	Tasked with administering payrolls
	Ensuring compliance with taxation legislation
	Handles all financial transactions for Eric Pearson® Remote Tech Support, Inc.
	Serves as internal auditor for Eric Pearson® Remote Tech Support, Inc.
	Tasked with creating content for the organization as it relates to advertising
	Tasked with creating content/buzz words that will help attract traffic
	Tasked with Search Engine Optimization (SEO)
	Tasked with engaging internet users to get help statistics and leads
	Liaising and working effectively With other staff members to generate sales for our clients
	Tasked with welcoming clients and potential clients by greeting them in person, online or on the telephone; answering or directing inquiries.
	Makes sure that all contacts with clients (e-mail, walk-In center, SMS or phone) provides the client with a personalized customer service experience of the highest level
	Through interaction with clients on the phone, uses every opportunity to build client’s interest in the company’s products and services
	Manages administrative duties assigned by the creative director in an effective and timely manner
	Consistently stays abreast of any new information on the organizations’ promotional campaigns etc. to ensure accurate and helpful information are supplied to clients when they make enquiries.

6. SWOT Analysis
We at Eric Pearson® Remote Tech Support, Inc. understand that conducting a SWOT Analysis is very necessary to any new venture, as it is an in-depth look at our Strengths, Weaknesses, Opportunities, and Threats. We also understand that we are in a highly competitive and profitable market in a growing economy.
We envisage our strengths as our ability to respond to the market and to provide custom designed technological services. Here is a summary of the SWOT Analysis;
	In-depth Knowledge. From our extensive research, our competitors are mostly retailers, pushing boxes. We know systems, networks, connectivity, programming, and data management.
	Relationship Business. Our plans to get to know our customers, one by one. Our direct sales efforts will seek to maintain a relationship with our customers.
	Diversified market segments. The array of products and services we intend to provide will ensure the lack of dependency on one particular market.
	Diversified workforce. Our management team at Eric Pearson® Remote Tech Support, Inc. plans to jointly develop business strategy and long-term plans with its strategic allies, having wide experience in their respective market and product know-how, and strong technical skills and business know-how.
	We understand that putting together new business practices and personnel who have not previously worked together presents a challenge to our company.
	Our limited financial base compared to the current major players in the computer service industry.

Opportunities
	Technological advancement. The growing opportunities presented everyday by technology offers us another area of strength in comparison to the box-on-the-shelf major stores. Our potential customers want more help with their network and gadgets, and we intend to be in a better position to give it to them.
	As our target market needs more service, our competitors are less likely than ever to provide it.
	Innovation reduces the life cycles of products and hence the need to act timely on the market.
	Issues of decision-makers over ease of access and overall security of new technologies may need to be addressed.

7. MARKET ANALYSIS
	Market Trend

We at Eric Pearson® Remote Tech Support, Inc. believe that staying ahead of the curve in our industry can be important to exceed expectations with customer service and make it a competitive advantage during the sales process. From our research, we were able to find out that some companies are starting to utilize external chat bots for requests like addresses, hours of operation, and phone numbers.
On the back end, complex automation rules created in customer service software are enabling agents in the industry to work more efficiently as applicable tickets and information are routed directly to them with little effort. As a remote tech support firm, we understand that having a cloud-based customer service software solution in place lets agents around the world help customers anywhere, any time.
It provides a full history of all past communication and detailed “notes” (i.e. top customer, demanding personality, etc.) so all team members can be in a better position to be successful. All of this information makes agents smarter than ever and better equipped to find the right answer and deliver it in a manner the customer will accept.
Another reason many companies are investing in customer service technology is because of the strong customer demand and response for customer self-service solutions. Now that these solutions are included automatically within customer service software, there is little reason for companies to not have an online support presence.
We at Eric Pearson® Remote Tech Support, Inc. expect the number of system integrations to grow and for B2B integration solutions to become not only more complex but also more seamless. The amount of information shared between systems will increase and a wider acceptance of “webhook” technology will make it easier for more integration to share information in real-time.
We also understand that over the past decade, mobile has significantly changed the ways companies provide customer service. With USA smartphone ownership in 2017 (77%) more than double what it was in 2011 (35%), companies will continue to pivot away from traditional phone support and become more well-versed in other offerings.
Self-service is obviously on the list, but one that will continue to grow and see increased usage is live chat. Having a chat solution built-in to customer service software with easy access to information and conversation history helps to boost response times and decrease the disconnection rate.
From our extensive research, there are only two common themes that remain consistent in our industry – technology and communication enablement. We believe that companies will continue to use technology so customers can find their own answers easier (through personalized self-service) and agents can be more efficient in assisting customers.
8. Our Target Market
We at Eric Pearson® Remote Tech Support, Inc. plan to focus on proactive, market seeking organizations that want to ensure an efficient and effective IT system that will assist in the realization of their business objectives.
We envisage that our target companies are big enough to need the high-quality IT management we offer, but too small to have a separate computer management staff. But, our most important group of potential customers will be business executives in large, medium, and small corporations.
They will include marketing managers, general managers, sales managers, and other decision makers who often need to access company data and information in their various business decisions. These individuals will not waste their time or money looking for bargain information, questionable expertise, or cheap computers and accessories.
We also hope to offer an attractive development alternative to the company that is management constrained and unable to address opportunities in new markets and new market segments, due to technological shortfalls. Our target businesses are dependent on reliable information technology.
They use the computers for a complete range of functions, beginning with the core administration information such as accounting and record entry, communications, and personal productivity.
	Our Competitive Advantage

A huge majority of proactive, market-oriented businesses understand the value of having an efficient computer system. They are much more likely to pay for them when the offering and benefits are clearly stated. We at Eric Pearson® Remote Tech Support, Inc. understand that we will compete more against the box pushers than other service providers.
We need to effectively compete against the idea that once a computer is outdated, businesses should buy new ones, when with ongoing service and support, they can be upgraded. The most crucial element of general competition, by far, is what it takes to keep clients for repeat business. Our competitive advantage at Eric Pearson® Remote Tech Support, Inc. is our positioning as a strategic ally with our clients.
We believe that by building a business based on long-standing relationships with satisfied clients, we will simultaneously build defenses against competition. We’ve noted that the longer the relationship stands, the more we help our clients understand what we offer them and why they need it.
9. SALES AND MARKETING STRATEGY
Our plan at Eric Pearson® Remote Tech Support, Inc. is to showcase our company as a strategic ally to our clients. We also plan to offer extremely reasonable prices in comparison to competition, and we need to be able to sustain that. Market penetration through lower prices shall be undertaken where need be, with premium pricing in the case of the upper-end of the market. We plan to use the following strategies to reach our targeted audience;
	Advertising

Our plan is to undertake extensive advertising of the services we offer. We will instill awareness and knowledge of our existence in the marketplace, which shall convert into market share. We will advertise in business and IT magazines that are read by our target market and will ensure we are adequately exposed on the market. Advertising will also be conducted through television, radio, newspapers/magazines, and the internet.
We plan to make sure that once we gain a customer, we never lose him/her. That is why to further accomplish this, we must work to create and maintain relationships. Word of mouth will be a powerful form of marketing due to the fact that its flexibility will enable us to match the customer’s needs to specific attributes of our services.
	Public Relations

Knowing that we are relatively new in our industry, there will be a need to organize an event to clearly introduce ourselves onto the market. We plan invite potential customers, senior officials, possibly including a government official and other stakeholders, so as to penetrate the market. We also intend to place news stories and features in magazines and newspapers to keep stakeholders updated on the latest developments and to increase awareness.
	Internet Marketing

We at Eric Pearson® Remote Tech Support, Inc. also plan to sell our services over the Internet as it is cost effective to reach a large number of potential clients.
10. Sales Forecast
One of our objectives at Eric Pearson® Remote Tech Support, Inc. is to create and maintain a follow-up strategy to gauge performance with all our clients. We will also formalize and measure cross-functional working communication so as to ensure that the various departments work harmoniously towards attainment of company objectives. We will also instill a culture of continuous improvement in customer satisfaction and efficiency.
For us to understand what we have and what we are expected to reach, we’ve analyzed and set out our sales forecast. This sales forecast was done after extensive research, discussion, and analysis of what is obtainable in the industry. Outlined below is the sales projection for Eric Pearson® Remote Tech Support, Inc.
	First Fiscal Year:  $600,000
	Second Fiscal Year:  $1,340,000
	Third Fiscal Year:  $4,878,000

11. Publicity and Advertising Strategy
We will base our publicity strategy primarily on informing prospective customers of our existence and making the right information available to our target customer. We intend to make use of forearm promotional campaign to introduce all our products and services to the market. In alignment with our marketing plan, we will take advantage of several media sources in announcing our services and in the process enforcing awareness of our existence.
	Sources of Income

We at Eric Pearson® Remote Tech Support, Inc. will gain revenue streams from a combination of licensing agreements, sales commissions, monthly subscriptions, registration fees, network access charges, service fees, transaction charges, training, promotional incentive programs, and sales of hardware and software. We believe that our derived value will come from the key partnerships established.
12. Our Pricing Strategy
We understand that we will be competing more against the box pushers than other service providers. We plan to charge appropriately for the high-end, high-quality service and support we offer. We plan to ensure that our revenue structure matches our cost structure, so the salaries we pay to obtain good service and support must be balanced by the revenue we charge. That is why we must make sure that we deliver and charge for service.
	Payment Options

We at Eric Pearson® Remote Tech Support, Inc. are very much ready to provide a wide range of payment methods to suit our clients. We hope to make our business dealings so simple and comfortable for our customers. We’ve also employed the use of a banking platform to help us provide all the services we will be offering below.
	Payment by via bank transfer
	Payment via online bank transfer
	Payment via check
	Payment via bank draft
	Payment via mobile money
	Payment with cash

13. Startup Expenditure (Budget)
Just like we stated above, our intangible resources, such as our ability to relate to customers regarding their needs and wants, management style, corporate culture and commitment will go a long way to boost our brand. We believe that these elements will differentiate us from our competitors and propel us towards the development of a sustainable competitive advantage.
Our plan was never to just market and sell our product and services, but to provide customized services and products that will enable our clients to optimize their output and, assist in the attainment of their goals and objectives. Outlined below is a detailed cost analysis of starting Eric Pearson® Remote Tech Support, Inc.;
	Incorporating fees in the United States of America will cost – $750.
	The budget for Liability insurance, permits and license will cost – $40,000
	Leasing/renting an office space in a good location in Silicon Valley that will accommodate the number of employees for at least 6 months (Re – Construction of the facility inclusive) will cost – $165,000.
	The cost for furnishing and equipping the office (computers, printers, projectors, markers, servers / internet facility, furniture, telephones, filing cabinets, and electronics) will cost – $40,000
	The amount required to purchase the needed software applications – $3,500
	Launching an official Website will cost – $500
	Our budget for advertising and publicity – $40,000
	The amount needed to pay bills and staff members for at least 2 to 3 months – $100,000
	Additional Expenditure such as Business cards, Signage, Adverts and Promotions will cost – $5,000
	Miscellaneous – $10,000

From the above cost analysis, we need about $640,000 to start Eric Pearson® Remote Tech Support, Inc.
Generating Funding/Startup Capital for Eric Pearson® Remote Tech Support, Inc.
We at Eric Pearson® Remote Tech Support, Inc. want to finance growth mainly through cash flow and equity. This means we will have to grow more slowly than we might like. But the most important factor in our case is collection days. We can’t push our clients hard on collection days, because they are in larger companies and will normally have marketing authority, not financial authority.
That is why we need to develop a permanent system of receivables financing, using one of the established accounting systems. In turn we intend to ensure that our investors are compatible with our growth plan, management style, and vision. Compatibility in this regard means:
	A mutual respect and understanding for giving our customers value, and for maintaining a healthy and congenial workplace
	Sticking to our realistic forecasts, conservative cash flow, and financial management
	Cash flow as first priority, growth second, profits third
	Ability to follow the project objectives and contribute valuable input to strategy and implementation decisions.

14. Sustainability and Expansion Strategy
We envisage major growth in sales and operating expenses, and a bump in our collection days as we spread the business during expansion. Although we acknowledge that collection days are very important, we do not want to let our average collection days get above 30 under any circumstances.
This could cause a serious problem with cash flow, because our working capital situation is chronically tight. However, we recognize that we cannot control this factor easily, because of the relationship with our clients.
We also acknowledge that our initial marketing and training expenses will be relatively high as we seek to become known on the market. We believe that this will be brought about by the development of sales literature, advertising expenses, and function expenses.
As our market share grows and revenue is generated, further marketing programs and the expansion of those in existence at the time will be undertaken, to ensure market development. However, with time, these programs will start generating revenue for the business, which we shall reinvest.
It is also important to state that our macro-environment is very promising. Our business is in the middle of an unprecedented boom, as unimaginable advancement offers information technology like we never dreamed of. Meanwhile, all other signs are positive.
We believe that the current drive by the government towards a more diversified economy presents an opportunity for our business to excel in our intended markets, benefiting from the support of the concerned institutions and trade bodies.
We plan to ensure that our marketing strategy emphasizes focus. Our target market will include key decision-makers in business, which often order or recommend on behalf of the whole organization. We also plan to initially build image and awareness through consistency and distinctiveness in our product and service provision. We will also focus on delivering quality services that produce good referrals, which can then generate revenue.
We intend to have a heavy personal selling component, supported by regular advertising and we will always be active in our personal relationships with clients and strategic allies. We also intend to achieve growth by establishing a more enthusiastic customer culture than our competitors.
The strategy is to grow the business by nurturing customers, differentiating the product/service offering through service and staff behavior. We also believe that through the implementation of a fair, effective, and competitive remuneration policy we will optimize our human resource output and advancement.
Check List/Milestone
	Business Name Availability Check : Completed
	Business Incorporation: Completed
	Opening of Corporate Bank Accounts: Completed
	Opening Online Payment Platforms: Completed
	Application and Obtaining Tax Payer’s ID: In Progress
	Application for business license and permit: Completed
	Purchase of Insurance for the Business: Completed
	Conducting Feasibility Studies: Completed
	Leasing, renovating and equipping our facility: Completed
	Generating part of the startup capital from the founder: Completed
	Applications for Loan from our Bankers: In Progress
	Writing of Business Plan: Completed
	Drafting of Employee’s Handbook: Completed
	Drafting of Contract Documents: In Progress
	Design of The Company’s Logo: Completed
	Printing of Promotional Materials: Completed
	Recruitment of employees: In Progress
	Purchase of software applications, furniture, office equipment, electronic appliances and facility facelift: In progress
	Creating Official Website for the Company: In Progress
	Creating Awareness for the business (Business PR): In Progress
	Health and Safety and Fire Safety Arrangement: In Progress
	Establishing business relationship with banks, financial lending institutions, vendors and key players in the industry: In Progress
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Technology Business Plan Template
Written by Dave Lavinsky
Technology Business Plan
You’ve come to the right place to create your own Technology business plan.
We have helped over 1,000 entrepreneurs and business owners create business plans and many have used them to start or grow their Technology businesses.
Technology Business Plan Example & Template
Below is a Technology business plan template and sample to help you create each section of your own business plan.
Executive Summary
Business overview.
Kearney Tech Inc., located in Houston, Texas is a tech startup that focuses on developing and commercializing new artificial intelligence (AI) technology applications designed for small-to-medium sized businesses. The company has created proprietary technology that helps businesses improve their profitability by using AI to increase customer engagement. We offer multiple products, including AI hardware, marketing AI software, and CRM AI software. Many of our most basic services are free, but the rest can be accessed by paying a subscription fee. By providing flexible and affordable subscription options for our clients, Kearney Tech Inc. aims to be the next big technology company in the AI space for small and medium-sized businesses.
Kearney Tech Inc. was founded and is led by Abigail Kearney. Abigail has been a senior software engineer for nearly 10 years and has extensive experience in artificial intelligence and machine learning. In addition to her experience, she has a bachelor’s degree in computer science and an MBA. Her education and experience are sure to lead Kearney Tech Inc. to success.
Product Offering
Kearney Tech Inc. will showcase a variety of different applications for its AI technology that companies can utilize to increase their customer engagement from day one. Businesses can choose the platform package that works for them, based on a freemium subscription pricing structure.
The following are the services that Kearney Tech Inc. will provide:
	AI Hardware
	Marketing AI Software
	Customer Relationship Management AI Software
	Customer Support AI Software
	Technology Training: Training sessions on how to use our AI solutions and integrate them into their businesses

Customer Focus
Kearney Tech Inc. will serve small to medium-sized businesses within a 30-mile radius of Houston, Texas. Many of the businesses in our target demographic are startups looking to expand their reach and thus would benefit from technology that can increase their customer base.
Management Team
Kearney Tech Inc. will also employ an experienced assistant to work as a business analyst and help with various administrative duties around the office. She will also hire several developers, salesmen, and other administrative staff to assist her.
Success Factors
Kearney Tech Inc. will be able to achieve success by offering the following competitive advantages:
	Management: Abigail Kearney has been extremely successful working in the technology industry and will be able to use her previous experience to provide the best service experience. Her unique qualifications will serve customers in a much more sophisticated manner than Kearney Tech Inc.’s competitors.
	Relationships: Abigail Kearney knows many of the local leaders, business managers, and other influencers within Houston, Texas. With her 10 years of experience and good relationships with business leaders in the area, she will be able to develop an initial client base.
	Proprietary technology : The company has developed proprietary AI technology that will be used to add new data sources, expand on valuable insights, launch advanced features like benchmarking, provide predictive and prescriptive analytics, and ensure self-guided data discovery.
	Client-oriented service: Kearney Tech Inc. will have full-time customer service and sales managers to keep in contact with clients and answer their everyday questions.

Financial Highlights
Kearney Tech Inc. is seeking a total funding of $400,000 of debt capital to open its office. The funding will be dedicated to office design, software development, marketing, and working capital. Specifically, these funds will be used as follows:
	Office design/build: $50,000
	Software development: $150,000
	Three months of overhead expenses (payroll, rent, utilities): $150,000
	Marketing costs: $25,000
	Working capital: $25,000

The following graph below outlines the pro forma financial projections for Kearney Tech Inc.:

Company Overview
Who is kearney tech inc..
Abigail began researching what it would take to create her own technology company and did a thorough analysis of the costs, market, demographics, and competition. Abigail has compiled enough information to develop her business plan in order to approach investors.
Kearney Tech Inc.’s History
Once her market analysis was complete, Abigail Kearney began surveying the local vacant office space and located an ideal location to house the technology company. Abigail Kearney incorporated Kearney Tech Inc. as a Limited Liability Corporation in April 2023.
Since incorporation, the company has achieved the following milestones:
	Located available office space for rent
	Developed the company’s name, logo, and website
	Determined equipment and necessary supplies
	Began recruiting key employees

Kearney Tech Inc. Services
Industry analysis.
As of 2021, the global technology industry was valued at approximately $5.2T. Of all countries worldwide, the United States currently has the largest technology market, with 32% of the market share at $1.7T. The technology industry in the U.S. accounts for a large part of the nation’s economy.
The Information Technology market can be segmented by categories such as software, devices, infrastructure IT and business services, emerging technology, and telecom services. In the United States, IT and business services hold the greatest market share (30%), followed by software (20%) and telecom services (20%).
Market drivers include the economy, employment rates, and the digital transformation of daily life for a growing number of people and businesses worldwide. Corporations and organizations are seeking IT service providers that can help improve their software, cybersecurity, data, and infrastructure. Technology companies that can provide products and services that cater to these issues can be competitive in the constantly evolving market.
Technology is an integral part of society. Developments in AI and machine learning are essential to keep society moving forward and make businesses more efficient. Therefore, businesses will always be in need of AI solutions to bring in more customers and streamline their services and products. According to Market Watch, the Technology industry is set to grow at a CAGR of 25.73% from now until 2027. Very few industries see this growth, which shows how much demand there is for technological solutions. Therefore, we expect Kearney Tech Inc. to see great success in our local market.
Customer Analysis
Demographic profile of target market.
Kearney Tech Inc. will serve the small and medium-sized businesses of Houston, Texas, and the surrounding areas.
Many small businesses in the community are startups or established enterprises looking to expand their reach and thus would benefit from technology that can increase their customer engagement.
Customer Segmentation
Kearney Tech Inc. will primarily target the following customer profiles:
	Small businesses
	Medium-sized businesses

Competitive Analysis
Direct and indirect competitors.
Kearney Tech Inc. will face competition from other companies with similar business profiles. A description of each competitor company is below.  
Tekuserv has been a reliable technology company in Houston, Texas for more than fifteen years. The company is known for its wide range of technology solutions that serve many small-to-medium-sized businesses. With its large number of experts focused on delivering customer satisfaction, the organization maintains its high standard of developing quality products and providing exceptional customer service. Tekuserv provides business software on a freemium subscription basis. It develops enterprise technology solutions with a focus on customer relationship management.  
Prime AI Business Solutions
Prime AI Business Solutions is a technology development company in Houston, Texas. In business for several years, the company has developed highly-rated AI solutions used by many well-known businesses in a variety of industries. Prime AI Business Solutions now offers a range of AI hardware and software products geared toward helping businesses of all sizes increase their customer base. The company has also introduced a “pay-as-you-grow” pricing model that scales to provide users with more support as they scale up.  
AICE Developments
AICE stands for Artificial Intelligence for Customer Engagement. AICE Developments is also a local technology company that manufactures and distributes a variety of technology products. AICE Developments was established in 2009 in Houston, Texas, providing integrated AI applications and platform services. Its products include applications and infrastructure offerings delivered through various IT deployment models, including on-premise deployments, cloud-based deployments, and hybrid deployments. The company serves automotive, financial services, healthcare, hospitality, retail, utilities, construction, etc. It provides AI solutions for enterprise marketing and customer engagement.
Competitive Advantage
Kearney Tech Inc. will be able to offer the following advantages over the competition:
	Proprietary technology: The company has developed proprietary AI technology that will be used to add new data sources, expand on valuable insights, launch advanced features like benchmarking, provide predictive and prescriptive analytics, and ensure self-guided data discovery.

Marketing Plan
Brand & value proposition.
Kearney Tech Inc. will offer a unique value proposition to its clientele:
	Service built on long-term relationships
	Big-firm expertise in a small-firm environment
	Thorough knowledge of the clients and their varying needs
	Proprietary technology developed by skilled software engineers

Promotions Strategy
The promotions strategy for Kearney Tech Inc. is as follows:
Kearney Tech Inc. understands that the best promotion comes from satisfied customers. The company will encourage its clients to refer other businesses by providing economic or financial incentives for every new client produced. This strategy will increase in effectiveness after the business has already been established.
Social Media
Kearney Tech Inc. will invest heavily in a social media advertising campaign. The brand manager will create the company’s social media accounts and invest in ads on all social media platforms. It will use targeted marketing to appeal to the target demographics.
Website/SEO
Kearney Tech Inc. will invest heavily in developing a professional website that displays all of the features and benefits of the technology company. It will also invest heavily in SEO so that the brand’s website will appear at the top of search engine results.
Direct Mail
Kearney Tech Inc. will blanket businesses with direct mail pieces. These pieces will provide general information on Kearney Tech Inc., offer discounts, and/or provide other incentives for companies to use the AI platform.
Kearney Tech Inc.’s pricing will be on par with competitors so clients feel they receive great value when purchasing the technology.
Operations Plan
The following will be the operations plan for Kearney Tech Inc.:
Operation Functions:
	Abigail Kearney will be the Owner and CEO of the company. She will oversee all the operations and executive functions of the company. In the beginning, she will also provide customer support and market/sell AI products to potential clients.
	Abigail will employ an experienced assistant to work as a business analyst and help with various administrative duties around the office.
	Abigail will also hire several developers to maintain and develop AI products and services.
	Abigail will also hire a solid sales team to sell our products to potential clients. As the company grows, she will also hire a team that is solely dedicated to customer service.

Milestones:
Kearney Tech Inc. will have the following milestones completed in the next six months.
5/2023 – Finalize lease agreement
6/2023 – Design and build out Kearney Tech Inc.
7/2023 – Hire and train initial staff
8/2023 – Kickoff of promotional campaign
9/2023 – Launch Kearney Tech Inc.
10/2023 – Reach break-even
Financial Plan
Key revenue & costs.
Kearney Tech Inc.’s revenues will come primarily from its technology solution subscription sales. The company will use a freemium subscription model, in which basic functions can be used by any company for free. Additional solutions and support will be available in a tiered package model based on the enterprises’ size and the number of users.
The office lease, equipment, supplies, and labor expenses will be the key cost drivers of Kearney Tech Inc. Ongoing marketing expenditures are also notable cost drivers for Kearney Tech Inc.
Funding Requirements and Use of Funds
Key assumptions.
The following outlines the key assumptions required in order to achieve the revenue and cost numbers in the financials and pay off the startup business loan.
	Average number of clients per month
	Annual rent: $20,000


Financial Projections
Income statement, balance sheet, cash flow statement, technology business plan faqs, what is a technology business plan.
A technology business plan is a plan to start and/or grow your technology business. Among other things, it outlines your business concept, identifies your target customers, presents your marketing plan and details your financial projections. You can easily complete your Technology business plan using our Technology Business Plan Template here .
What are the Main Types of Technology Businesses?
There are a number of different kinds of technology businesses, some examples include: Network technology, Software technology, and Customer relationship technology.
How Do You Get Funding for Your Technology Business Plan?
Technology businesses are often funded through small business loans. Personal savings, credit card financing and angel investors are also popular forms of funding.
What are the Steps To Start a Technology Business?
Starting a technology business can be an exciting endeavor. Having a clear roadmap of the steps to start a business will help you stay focused on your goals and get started faster.
1. Develop A Technology Business Plan - The first step in starting a business is to create a detailed technology business plan that outlines all aspects of the venture. This should include potential market size and target customers, the services or products you will offer, pricing strategies and a detailed financial forecast.
2. Choose Your Legal Structure - It's important to select an appropriate legal entity for your technology business. This could be a limited liability company (LLC), corporation, partnership, or sole proprietorship. Each type has its own benefits and drawbacks so it’s important to do research and choose wisely so that your technology business is in compliance with local laws.
3. Register Your Technology Business - Once you have chosen a legal structure, the next step is to register your technology business with the government or state where you’re operating from. This includes obtaining licenses and permits as required by federal, state, and local laws.
4. Identify Financing Options - It’s likely that you’ll need some capital to start your technology business, so take some time to identify what financing options are available such as bank loans, investor funding, grants, or crowdfunding platforms.
5. Choose a Location - Whether you plan on operating out of a physical location or not, you should always have an idea of where you’ll be based should it become necessary in the future as well as what kind of space would be suitable for your operations.
6. Hire Employees - There are several ways to find qualified employees including job boards like LinkedIn or Indeed as well as hiring agencies if needed – depending on what type of employees you need it might also be more effective to reach out directly through networking events.
7. Acquire Necessary Technology Equipment & Supplies - In order to start your technology business, you'll need to purchase all of the necessary equipment and supplies to run a successful operation.
8. Market & Promote Your Business - Once you have all the necessary pieces in place, it’s time to start promoting and marketing your technology business. This includes creating a website, utilizing social media platforms like Facebook or Twitter, and having an effective Search Engine Optimization (SEO) strategy. You should also consider traditional marketing techniques such as radio or print advertising.
Learn more about how to start a successful Technology business: How to Start a Tech Company
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Many entrepreneurs still overlook the importance of a technology startup business plan. In a space as competitive as the tech industry, a lack of preparation will surely pave the way to disappointment.
Instead of diving in without any concrete strategy, a plan provides a foundation for sustainable business growth.
In this article, we’ll explore the essential elements of a tech startup business plan, and provide the insights you need to create a plan for success.
What Is A Business Plan?
A tech startup business plan is a document that details the premise of your technology business, summarizing vital financial objectives and operational goals, as well as details on how you will accomplish these goals.
Put simply:
It’s a road map that describes what you intend to do, and how you intend to do it.
A typical business plan will comprise the following seven elements:
	Executive Summary
	Company Description

Market Research
	Description of Products and/or Services
	Management & Operational Structure
	Marketing Plan
	Financial Plan

3 Reasons You Need a Business Plan
Before we dive into the individual aspects of a startup business plan, let’s first consider why you need one.
Just what are the benefits of a business plan?
1. It Offers Greater Clarity
Having a business plan will give you a much better understanding of your business and the objectives you are trying to achieve. Even the most basic technology startup business plan example will seek to define your goals in more objective terms.
For example, you can set specific targets for website traffic, sales volumes, or profit margins. This makes it easier to track and measure success and aligns your decision-making with sales and marketing initiatives.
2. It Increases the Chances of Success
A report from the Harvard Business Review found that companies with a business plan are 16% more likely to succeed.
Furthermore, companies that have a business plan also enjoy higher growth rates than companies without a plan.
3. You Are More Likely to Get Investment
Angel investors and venture capitalists aren’t in the habit of making bad bets. When they part with large sums of money, it’s a carefully considered decision they base on the likelihood of earning a positive return on investment (ROI). When you have a business plan, you give your startup strategic focus, which helps you create an identity that is built to succeed. This makes for a more attractive prospect in the eyes of investors, so it’s easier to raise capital for your startup when you have a plan.
How to Write a Business Plan for Your Tech Startup (7-Steps)
So, now that you understand the motivation behind creating a tech startup business plan, it’s time to see how it’s done. By including the seven elements below, you’ll have a plan that gives your company a much stronger footing.
1. Executive Summary
The executive summary is, without a doubt, the most critical element of your tech startup business plan. Despite this, a lot of plans fail here because the summary doesn’t captivate readers. If you can’t hook prospective investors, partners, or employees with your executive summary, they may never read the rest of your business plan.

Source: The Balance
This section should be compelling yet concise, giving people enough to understand what makes your startup unique, and how it will be able to offer solutions in an existing, competitive market.
While you want to keep it brief, there is a lot to pack into this opening section of your business plan. Here are the crucial components of an executive summary:
	Business Model – What is your product or service? How will you make money?
	Target Market – Who will benefit from this product or service?
	Business Opportunity – Why do consumers need your product or service?
	Marketing Strategy – How will these consumers learn more about your product or service?
	Competition – What other companies are competing for market share?
	Goals – How will your startup transform the marketplace with this product or service?

As the executive summary is such a vital aspect, it’s a smart move to write it last. By waiting until you have finished the rest of the business plan, you can draw from the other sections to craft an excellent executive summary.
2. Company Summary
The company summary essentially boils down to a single sentence, otherwise known as a headline statement.  When it’s done right, this summary can be the perfect elevator pitch to capture the imagination of would-be financial backers or partners, and it will serve as a natural lead-in to your more detailed business plan.

Source: Gusto (credit: LivePlan)
The company summary or headline statement should do the following:
	Give people a brief overview of what your company does.
	Communicate the value you offer.
	Highlight the opportunity in the market.

Here is a good template to create your company summary:
<Your company> is a <type of business> who sells <product or service> to <target customer> , who needs <solution> , but doesn’t get it from <competition> .
Don’t worry if you can’t create the perfect summary now. When you develop your business plan, you will get a better understanding of what this headline statement should be, and then you can refine it to reflect your vision and value proposition.
We’re sure you have a great idea, but that’s no guarantee that everyone is going to love it as much as you do. No matter how good you think your startup may be, you still need to conduct proper market research to learn more about your ideal customers and competitors.
Identify your Target Market
Without a viable market for your product or service, your business is doomed.
Many startups have failed quickly because the owners were so obsessed with their own product that they were effectively blind to the fact that nobody else cared about it.

Source: CB Insights Image: Cleveroad
Initially, you can adopt a broad scope to get a sense of your total addressable market (TAM), which is the potential revenue opportunity your new product or service could generate. Of course, with the competition, and changing consumer interests, it’s unlikely you will dominate the entire TAM.
Once you have this broad idea, you can hone your sights to go more niche. While this presents a smaller audience, it is more effective. By narrowing your targeting, you can market to a more engaged audience that will be more receptive and likely to purchase your product or service.
Consider the following factors when segmenting your audience:
	Demographic – What age group? What gender?
	Geographic – In what country or city do your prospects live?
	Behavior – What websites/blogs/news sources do they use? What are their purchasing habits? What retail sites or brands do they buy from?

With in-depth data analysis and evaluation of your prospective customers, you can create detailed buyer personas that help you refine your marketing strategies.
Perform Competitor Analysis
During the market research stage of your tech startup business plan, you should also carry out a thorough competitor analysis.
This will help you determine the key differentiators between your company and the competition.
Ask yourself these questions:
	Why should people choose my product or service?
	How can I improve on the existing solutions in the market?
	Why do people not already buy the products in the market?

By thinking about current trends or flaws in existing products, you can identify opportunities for innovation so that your business can connect with customers on a deeper level.
Knowing your audience is crucial, and therefore, your business plan must demonstrate a deep understanding of your target market, and your competitors.
3. Description of Products and/or Services
Here, you must highlight the link between what you are offering, and what people need, so you can prove that people are ready and willing to pay for your product or service.
Research Problems in Market
It helps to conduct some face-to-face research, asking potential customers about the problems they have. Don’t try to usher the conversation in any direction or shoehorn their answers to fit your product – instead, look to learn from their honest responses about the solutions they need.
You should do this research before creating the product. After all, it makes more sense to create a product for an existing problem, instead of trying to find a problem for your product.

Source: ProductTribe
Tailor Product to Problems
After doing your research on the existing problems in the market, trim your list to focus on a few of the most important issues. Describe how your product or service will be the ultimate solution to these problems.
For instance, if people believe the existing solutions are too expensive, you can offer a product with a more attractive price point.
By matching up consumer problems with specific solutions, you can develop a product or service that has a more significant value proposition.
4. Management & Operational Structure
The next stage of the traditional technology startup business plan template delves into the people that make up your company. You must highlight the strengths and experience of your existing team, as new partners effectively invest their money in the team as much as the business idea.
Ideally, your team will consist of several experts whose respective skill-sets complement one another. For example, your tech startup may have a coder, a graphic designer, an inbound marketing expert, and a sales professional. Discuss the merits of each team member to convey the value they add to the business.
You can also speculate about prospective new hires and the key attributes you will seek in future team members. If you haven’t already got a chief financial officer (CFO), it’s a smart move to mention adding one soon. This will add backbone to your business plan by reassuring people that you have good financial sense.
Organizational Chart
Here, your plan should clearly define the organizational structure of your startup. For now, it may just be you and a couple of business partners.
However, by including a graphic that visualizes the structure you intend to build, people will get a clear understanding of the distribution of power and chain of command.
For example, it may look something like this:

Having a hierarchy prepared before starting helps prevent any debates about who is in charge of each department, and makes it easier to understand who reports to who.
5. Marketing and Sales plan
No tech startup business plan would be complete without mentioning the marketing and sales strategies you intend to use.
Sales channels
To clarify the difference, marketing channels are used to promote your business, and its products or services, whereas sales channels are the mediums that enable people to purchase those products or services.
You may only have one direct sales channel to begin with, such as an online e-commerce store. Make sure you explain it in your business plan.
Marketing activities
In this section, you must detail how you will acquire leads and customers.
At the base level, you should do the following:
	Launch a company website
	Develop strategy to get organic traffic (i.e. visitors from search engines like Google)
	Develop a PPC strategy to get immediate online exposure for your most important product/service keywords
	Develop channel partnerships
	Build an email subscriber list


Over time, you can use marketing to nurture stronger customer relationships, which in turn, help you build an audience of loyal followers that will, hopefully, become customers.
The marketing section of your business plan will need to account for several factors, including your goals, risks in the market, and your budget. Which brings us to the final aspect of your tech startup business plan.
6. Financial Plan
Lastly, any good business plan must include pertinent details about your company budget and sales goals.
This can be daunting for many new entrepreneurs and is all the more challenging when you have no balance sheets, cash flow reports, or even any stable income on which to base your projections.
That being said, it’s still possible to make educated projections – so long as you have done solid market research.
When it comes to financial matters, your business plan should include details about:
	Revenue streams – how will the company generate income?
	Major expenses – What high costs do you anticipate in the year ahead?
	Salary demands – Are you still bootstrapping or are you and the partners taking a salary? If so, how much?
	Financial milestones – Detail your expansion strategy by considering future hires or store openings that will impact the books.

Many startups aren’t profitable in the first year. Your financial projections should maintain a long-term view for success, keeping ambitions realistic and honest. That way, you’ll be able to produce a more accurate break-even analysis .

With these long-term projections, you must consider the financial impact of expanding. You may be making more money in Year 3, but opening a new store will set you back.
Keep everything in perspective and make sure you don’t set yourself or your investors up for any nasty shocks down the road.
5 Tech Startup Business Plan Templates
When you have all the elements above in place, your business plan will be in good shape. However, presentation matters. If you want to make the best first impression, getting creative with your technology startup business plan template can make a big difference.
Not only will your research and expertise shine through, but you will have a visually stunning presentation that catches the eye of investors.
Here are five tech business plan examples to inspire you.
Business Plan Infographic PowerPoint
This plan allows you to present in-depth market analysis, statistics, and projections in a professional visual infographic. With several hundred editable slide options, it’s well worth the $16 fee for the license.

Source: Medium
Emaze Business Planning With Analytics
This is more than the average technology startup business plan template. Emaze has a diverse array of creative collaboration tools, making it easy and enjoyable for teams to create unique plans together from any of the built-in templates. Furthermore, you can incorporate analytics, which is perfect for impressing investors. That said, $19 per month for the premium version may seem a little steep for some small businesses.

Source: Emaze
Lean Canvas 1-Page Business Plan
A tech startup business plan doesn’t need to take weeks to create. In fact, with this template, you can have a basic – yet brilliant – business plan all together on a single page in just 20 minutes.

Source: Lean Stack
StartUp Pitch
For $15, you can access the full array of colorful slides in this presentation, which are all customizable to your needs. This template includes many ready-made aspects of the typical business plan, such as SWOT analysis, competitor analysis, and project timelines.

Source: Envato
This is another user-friendly tool for creating short business plans. You enter the information, and then LivePlan will generate a one-page plan in an infographic style.

Source: LivePlan
Make Your Tech Startup Business Plan a Priority
It’s not enough to have a great startup idea.
If you want to stand out from the pack, secure investment, and build a successful company that can earn real profits, growth, and customer loyalty, then you absolutely must have a solid tech startup business plan.
It’s time to create yours.
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Technology business plan for starting your own business
If there is one field that cannot go out of business within the foreseeable future, that is the technology business. This business has been growing vastly since the start of this century. There are more technology businesses out there than you can count, yet there is a capacity for new entrants in this field. We have made this business plan for technology company to tell you in sheer detail how to start a information technology company.
This business plan is based on the real-life example of MacArthur Tech Services. Let’s see how this business plan for investors can help you make money.
Executive Summary
2.1 the business.
MacArthur Tech Services will be a licensed and register tech services provider in Detroit. It will be owned by Maximilien MacArthur who is a former executive from Silicon Valley and has worked for many tech startups. This business plan for tech startup will help you learn from MacArthur’s experience.
2.2 Management of Technology Company
While explaining how to start a business solutions company, the first important thing to learn is the management of the company. You need to know the managemental hierarchy of the company for technology business setting up. This can also be used as a business plan for bank to get debt financing for your startup.
The management of MacArthur Tech Services will mainly be handled by MacArthur himself. He will hire experts of the field to help him with the operations.
2.3 Customers of Technology Company
As a semiconductor business plan is a vast field, we need to determine what customers would we be dealing. This includes the following:
	Domestic Customers

These customers will include the people who:
	Want to get their personal computers fixed.
	Want home-based tech and connectivity solutions.
	Want consultancy for domestic tech setups.
	Business Clients

These will be slightly bigger than the domestic customers and will include:
	Businesses looking for automation.
	Small businesses looking for digital bookkeeping and inventory management.
	Businesses looking for better connectivity solutions.

These customers will need:
	Campus management solutions.
	Labs and Library computer setups.
	Corporate Clients

These will be the biggest clients needing corporate-grade computing and tech solutions.
2.4 Business Target
The target will be to become the leading provider of tech services in all of North America.

Company Summary
3.1 company owner.
The owner of MacArthur Tech Services, Maximilien MacArthur is an expert of the field. He started his career with a repair shop and that makes and excellent computer repair business plan today. He then moved to the Silicon Valley where he made a information technology business plan example by starting a number of companies and making them successful.
3.2 Why the Technology Company is being started
MacArthur has an extensive knowledge of the field and has set many information technology business continuity plan example. He has helped a number of tech companies successful and is now planning to make a company of his own. He is passionate about it and knows where there is a gap in this business and how he can make a name in this field.
3.3 How the Technology Company will be started
Step1: Planning
The next thing we need to cover in this technology business plan sample is the planning to start the business. No business plan for tech company can be complete without that.
We need to plan everything from the number of employees and starting costs for the business to the perspective customers.
Step2: Branding
People trust the companies that have established brand names. In order to make it successful, our tech company will also establish a strong brand name. An impressive brand logo, moto, and color scheme will be chosen to make this happen.
Step3: Establish Your Office
MacArthur Tech Services will have an office in downtown Detroit from where all the services of the company will be extended to the customers.
Step4: Establish a Web Presence
No successful technology business plan can be complete without web presence. An extensive website will be launched for customers to interact with MacArthur Tech services.
Step5: Promote and Market
All possible ways of communication will be used to make sure that MacArthur Tech Services is known in all of Detroit and Michigan.

The next thing we need to address in this technology business plan template are the services we will be providing. As Technology is a vast field and no single company can reasonably cover all aspects of the industry, we’ll offer limited services in this information technology startup business plan and will try to be the best at them.
The main services provided by MacArthur Tech Services will include:
	Connectivity Solutions

This area of the services provided by MacArthur will include:
	Connectivity solutions for domestic clients.
	Connectivity solutions for offices and businesses.
	Connectivity solutions for corporate clients.
	Tech Equipment Supply

This segment of MacArthur’s services will include the supply of:
	Projectors.
	Tech Support Services

MacArthur Tech Services will offer support services for clients. These will include support for:
	Any major fault in tech setups.
	Break down of network or mainframes in offices.
	Personal and domestic tech support.

MacArthur Tech Services will maintain a 247 support helpline to provide support to people facing any tech problems.
	Tech Consultancy

For the clients that do not know where to start with tech, we’ll be giving tech consultancy services.
Marketing Analysis of Technology Business
Excellent work.
excellent work, competent advice. Alex is very friendly, great communication. 100% I recommend CGS capital. Thank you so much for your hard work!
If you want to know how to write a business plan for a tech startup, the most important thing for that is the marketing analysis of the technical business plan sample. We are performing the marketing analysis of thebusiness plan technology description to make things easier for you. It is paramount to have an extensive knowledge of thetechnology business solutions if we want the business to be successful.
5.1 Market Trends
The tech market is one of the most fast-growing ones all over the globe. Most of the top companies and richest people in the world right now are associated with this field. We have seen a lot of tech companies come forth and be successful in this field.
The field is a bit saturated but there is always place for companies that come with the intention of providing exalted services in this industry.
5.2 Marketing Segmentation
The customers of our Tech business will be divided in the following market segments. Each segment will need its own specialized set of services.

5.2.1 Domestic Individual Customers
These will be the lowest paying customers but with the largest values. Anyone who needs an advice on what laptop to buy to anyone looking for someone to setup their workstation will fall into this category. We will provide all the services from the installation of Windows to replacing broken displays. Our focus will be to make repeat customers here.
5.2.2 Small Large Businesses
The businesses needing services for their tech setup will also be our customers. We will provide them with the services including automation, bookkeeping, inventory management, connectivity, and all other services that they might need.
5.2.3 Corporate Clients
This will be the market segment for us that will make the bulk of our income. They will be in a lesser number but will pay the premium prices. We will offer all the services from cloud computing to blockchain services and all other tech-related services a corporation might need.
5.2.4 Nonprofits
Lastly, we will offer discounted services to the nonprofit segment of the business to play our role in community development.
5.3 Business Target
	To become the leader in tech services in all of North America within 5 years.
	To provide impeccable tech services to our clients.
	To expand to at least 3 more states by the end of year 1.
	To start making an annual $368,000 in profit by the end of year 3.

5.4 Product Pricing
We will keep the product prices lower than the market average at the start. This will be done to attract the customers and once we have enough of them, we will move on to increase the prices.
Marketing Strategy
Now that we know the market we are going to enter, the next thing we need is a business plan in marketing to make sure we get our business objectives. As the Tech market is a saturated one, marketing is one of the decisive factors that can make any information technology business proposal template a success.
We need to be objective here and use any competitive leverage that we have in order for us to be successful and we’ll spare no expense in making sure that our technology startup company is successful.
6.1 Competitive Analysis
	The thing that will give us an edge on the competitors will be the extensive experience of the owner Mr. MacArthur.
	We will provide top-notch service and only the best of the best equipment to earn permanent recurring clients.
	We will provide a 247 support helpline, something that can make a huge difference and something not much of the competitors have.

6.2 Sales Strategy
	We’ll target the domestic, business, and corporate market at once to ensure that we get the best sales margin.
	We’ll provide a one-year warranty on all our products and services to make people rely on us and buy from us.
	Like all the best biotech business plans , we will offer huge discounts for the first two months.

6.3 Sales Monthly

6.4 Sales Yearly

6.5 Sales Forecast

Personnel plan
The next thing needed for writing a business plan for a tech startup is the planning of the staff needed to efficiently run the company. This business plan for a web hosting and other tech services needs a number of skilled people to help it run properly. As the main focus of this business is to provide technical support and services, these employees will be the most valuable asset of the business.
7.1 Company Staff
	Maximilien MacArthur will be the owner and the CEO.
	1 General Manager.
	1 Operations Manager.
	1 Liaison Manager.
	5 Technicians.
	2 Engineers.
	5 Support Agents.
	2 Drivers for the support Team.
	2 Office Boys.
	1 Receptionist.
	1 Accountant.

7.2 Average Salary of Employees
Financial plan.
This last part of this business plan information technology company is the financial planning of the business. The recipe for a successful business is to decrease the expenses and increase the income of the setup. To make this happen, we have to have a clear idea of the expenses for starting and running the business. Let’s see a tentative budget planning for a technology business.
Here is a list of the expenditure for starting the business and running it until it starts generating enough revenue to fund itself and return profit.
	The cost of setting up the office.
	The cost of setting up an online presence.
	The cost of advertisement of the business.
	The salaries of the staff for the starting year.
	The cost of overheads included in running the business.

8.1 Important Assumptions
8.2 break-even analysis.

8.3 Projected Profit and Loss
8.3.1 profit monthly.

8.3.2 Profit Yearly

8.3.3 Gross Margin Monthly

8.3.4 Gross Margin Yearly

8.4 Projected Cash Flow

8.5 Projected Balance Sheet
8.6 business ratios.
Download technology business plan sample in pdf
Professional OGS capital writers specialized also in themes such as solid semiconductor business plan , best biotech business plan , business plan for PC fix , technology business plan , developing a business plan for tech, web hosting services business plan and many others.
OGSCapital’s team has assisted thousands of entrepreneurs with top-rate business plan development, consultancy and analysis. They’ve helped thousands of SME owners secure more than $1.5 billion in funding, and they can do the same for you.
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All Formats
Plan Templates
5+ tech startup business plan templates – pdf, word.
Making a business in the digital age ties up with technology. It is a big part of how the business is built from scratch. We really can’t deny how much of these technology is influencing our lives. When combined with business, it can yield to greater results. With this, tech startups have become a common trend as a business. You may also see Plan Templates .

	97+ Business Plan Templates
	28+ Business Plan Templates in Word

Technology Startup Business Plan Template

	Google Docs

Tech Startup Business Plan Template

Tech Startup Business Plan Sample

Tech Startup Business Plan Sample Format

Writing The Tech Startup Business Plan
1. start with the cover page, 2. give background and overview of the business, 3. state the products and its goals in the market, 4. attach additional documents, startup business plan.

Building A Tech Startup Business
1. see where you fit in, 2. contact potential customers, 3. validate the business idea, 4. look for a technical co-founder, 5. build the product, 6. sell the product beforehand, 7. getting the talent you need, 8. marketing effort, more in plan templates, tech fax cover sheet template, tech startup instagram story template, tech startup whatsapp post template, tech startup twitter post template, tech startup tumblr post template, tech startup pinterest pin template, tech startup linkedin post template, tech startup instagram post template, tech startup facebook post template, tech startup email signature template.
	7+ Financial Plan Templates
	10+ Operational Plan Templates
	9+ Training Plan Templates
	5+ Shooting Schedule Template
	11+ School Counselor Lesson Plan Templates in PDF | Word
	9+ Interdisciplinary Lesson Plan Templates in PDF | MS Word
	10+ Business Continuity Plan Templates in Google Docs | Ms Word | Pages | PDF
	18+ Compensation Plan Templates in Google Docs | MS Word | Pages | PDF
	10+ Executive Bonus Plan Templates in PDF
	8+ Facility Management Plan Templates in PDF
	10+ Diversity Recruitment Plan Templates in PDF | MS Word
	11+ Audit Corrective Action Plan Templates in MS Word | Excel | PDF
	9+ Recruitment Agency Marketing Plan Templates in PDF
	10+ Recruitment Marketing Plan Templates in PDF | MS Word
	10+ Student Recruitment Plan Templates in PDF | MS Word


Create a form in Word that users can complete or print
In Word, you can create a form that others can fill out and save or print.  To do this, you will start with baseline content in a document, potentially via a form template.  Then you can add content controls for elements such as check boxes, text boxes, date pickers, and drop-down lists. Optionally, these content controls can be linked to database information.  Following are the recommended action steps in sequence.  
Show the Developer tab
In Word, be sure you have the Developer tab displayed in the ribbon.  (See how here:  Show the developer tab .)
Open a template or a blank document on which to base the form
You can start with a template or just start from scratch with a blank document.
Start with a form template
Go to File > New .
In the  Search for online templates  field, type  Forms or the kind of form you want. Then press Enter .
In the displayed results, right-click any item, then select  Create. 
Start with a blank document 
Select Blank document .
Add content to the form
Go to the  Developer  tab Controls section where you can choose controls to add to your document or form. Hover over any icon therein to see what control type it represents. The various control types are described below. You can set properties on a control once it has been inserted.
To delete a content control, right-click it, then select Remove content control  in the pop-up menu. 
Note:  You can print a form that was created via content controls. However, the boxes around the content controls will not print.
Insert a text control
The rich text content control enables users to format text (e.g., bold, italic) and type multiple paragraphs. To limit these capabilities, use the plain text content control . 
Click or tap where you want to insert the control.

To learn about setting specific properties on these controls, see Set or change properties for content controls .
Insert a picture control
A picture control is most often used for templates, but you can also add a picture control to a form.

Insert a building block control
Use a building block control  when you want users to choose a specific block of text. These are helpful when you need to add different boilerplate text depending on the document's specific purpose. You can create rich text content controls for each version of the boilerplate text, and then use a building block control as the container for the rich text content controls.

Select Developer and content controls for the building block.

Insert a combo box or a drop-down list
In a combo box, users can select from a list of choices that you provide or they can type in their own information. In a drop-down list, users can only select from the list of choices.

Select the content control, and then select Properties .
To create a list of choices, select Add under Drop-Down List Properties .
Type a choice in Display Name , such as Yes , No , or Maybe .
Repeat this step until all of the choices are in the drop-down list.
Fill in any other properties that you want.
Note:  If you select the Contents cannot be edited check box, users won’t be able to click a choice.
Insert a date picker
Click or tap where you want to insert the date picker control.

Insert a check box
Click or tap where you want to insert the check box control.

Use the legacy form controls
Legacy form controls are for compatibility with older versions of Word and consist of legacy form and Active X controls.
Click or tap where you want to insert a legacy control.

Select the Legacy Form control or Active X Control that you want to include.
Set or change properties for content controls
Each content control has properties that you can set or change. For example, the Date Picker control offers options for the format you want to use to display the date.
Select the content control that you want to change.
Go to Developer > Properties .

Change the properties that you want.
Add protection to a form
If you want to limit how much others can edit or format a form, use the Restrict Editing command:
Open the form that you want to lock or protect.
Select Developer > Restrict Editing .

After selecting restrictions, select Yes, Start Enforcing Protection .

Advanced Tip:
If you want to protect only parts of the document, separate the document into sections and only protect the sections you want.
To do this, choose Select Sections in the Restrict Editing panel. For more info on sections, see Insert a section break .

If the developer tab isn't displayed in the ribbon, see Show the Developer tab .
Open a template or use a blank document
To create a form in Word that others can fill out, start with a template or document and add content controls. Content controls include things like check boxes, text boxes, and drop-down lists. If you’re familiar with databases, these content controls can even be linked to data.
Go to File > New from Template .

In Search, type form .
Double-click the template you want to use.
Select File > Save As , and pick a location to save the form.
In Save As , type a file name and then select Save .
Start with a blank document
Go to File > New Document .

Go to File > Save As .
Go to Developer , and then choose the controls that you want to add to the document or form. To remove a content control, select the control and press Delete. You can set Options on controls once inserted. From Options, you can add entry and exit macros to run when users interact with the controls, as well as list items for combo boxes, .
Adding content controls to your form
In the document, click or tap where you want to add a content control.
On Developer , select Text Box , Check Box , or Combo Box .

To set specific properties for the control, select Options , and set .
Repeat steps 1 through 3 for each control that you want to add.
Set options
Options let you set common settings, as well as control specific settings. Select a control and then select Options to set up or make changes.
Set common properties.
Select Macro to Run on lets you choose a recorded or custom macro to run on Entry or Exit from the field.
Bookmark Set a unique name or bookmark for each control.
Calculate on exit This forces Word to run or refresh any calculations, such as total price when the user exits the field.
Add Help Text Give hints or instructions for each field.
OK Saves settings and exits the panel.
Cancel Forgets changes and exits the panel.
Set specific properties for a Text box
Type Select form Regular text, Number, Date, Current Date, Current Time, or Calculation.
Default text sets optional instructional text that's displayed in the text box before the user types in the field. Set Text box enabled to allow the user to enter text into the field.
Maximum length sets the length of text that a user can enter. The default is Unlimited .
Text format can set whether text automatically formats to Uppercase , Lowercase , First capital, or Title case .
Text box enabled Lets the user enter text into a field. If there is default text, user text replaces it.
Set specific properties for a Check box .
Default Value Choose between Not checked or checked as default.
Checkbox size Set a size Exactly or Auto to change size as needed.
Check box enabled Lets the user check or clear the text box.
Set specific properties for a Combo box
Drop-down item Type in strings for the list box items. Press + or Enter to add an item to the list.
Items in drop-down list Shows your current list. Select an item and use the up or down arrows to change the order, Press - to remove a selected item.
Drop-down enabled Lets the user open the combo box and make selections.
Protect the form
Go to Developer > Protect Form .

Note:  To unprotect the form and continue editing, select Protect Form again.
Save and close the form.
Test the form (optional)
If you want, you can test the form before you distribute it.
Protect the form.
Reopen the form, fill it out as the user would, and then save a copy.
Creating fillable forms isn’t available in Word for the web.
You can create the form with the desktop version of Word with the instructions in Create a fillable form .
When you save the document and reopen it in Word for the web, you’ll see the changes you made.

Need more help?
Want more options.
Explore subscription benefits, browse training courses, learn how to secure your device, and more.

Microsoft 365 subscription benefits

Microsoft 365 training

Microsoft security

Accessibility center
Communities help you ask and answer questions, give feedback, and hear from experts with rich knowledge.

Ask the Microsoft Community

Microsoft Tech Community

Windows Insiders
Microsoft 365 Insiders
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Uni-tech Solutions is a consulting-oriented company, intending to fill in the market need for a professional, customer-focused IT company. The company emphasizes service and support to differentiate itself from more price-oriented computer companies. We are on the brink of penetrating a lucrative market in a rapidly growing industry. The current trend towards an increase in the number of entrepreneurs and competition amongst existing companies presents an opportunity for UNI-TECH Solutions to penetrate this market. Located at Maseru, we realize that, for us to prosper, we need to be flexible and responsive, to delight clients by providing them with what they want, when they want it, and before the competition can offer it. The company intends to achieve this through a solutions approach that is customer-centric, and in which the customer's business objectives enjoy top priority. Once the needs and processes are understood and described, leading edge products and best-of-industry...
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What is Crunchyroll?
	How much is it?
	Is there a free trial?

Does Crunchyroll have a free plan?
What devices support the crunchyroll app, what can i watch on crunchyroll, does crunchyroll have dubbed anime, is crunchyroll shutting down funimation, is crunchyroll worth it, what is crunchyroll the anime streaming service, explained.
Anime, or Japanese animation, has become so mainstream that it's now accessible to audiences worldwide. Most major streaming services, like Netflix and Hulu, offer a selection of popular titles. However, if you're looking for one service that just about has it all, Crunchyroll should be at the top of the list. 
Crunchyroll is home to hundreds of anime series and movies, old and new. From classics like "Akira" and "One Piece" to new hits like "Jujutsu Kaisen" and "Spy x Family," you're sure to find what you're looking for in its library. After its recent merger with Funimation, it has more to offer than ever.
Here's what you need to know about Crunchyroll, including how much it costs and how to watch for free.

Crunchyroll offers one of the largest collections of anime shows and movies you can stream online. Premium plans start at $8 a month for ad-free access to the entire Crunchyroll library.
Crunchyroll is a subscription streaming service owned by Sony that specializes in everything anime. Members can choose between three Premium plans or stream a limited content selection for free. 
Crunchyroll's Premium tiers have the most extensive library of anime titles compared to any major streaming service. The only notable series you won't find on Crunchyroll are originals exclusive to other platforms, like Netflix's "The Seven Deadly Sins" or Hulu's "Tokyo Revengers."
Crunchyroll also recently merged with Funimation, expanding its library even more. Existing Funimation subscribers can simply log in to Crunchyroll using their account credentials to activate their merged membership. 
In addition to streaming, Crunchyroll has the Crunchyroll Game Vault, a catalog of video games included with some of its Premium plans, and the Crunchyroll Store, an online shop dedicated to anime, manga, and related merch like figures and apparel.
How much is Crunchyroll Premium?
To watch everything on Crunchyroll, you must sign up for one of its Premium plans. Crunchyroll offers three subscription tiers with different benefits:
	Fan : $8/month for ad-free access on one device at a time.
	Mega Fan : $10/month for ad-free access on up to four devices simultaneously, offline viewing, the Crunchyroll Game Vault, and discounts at the Crunchyroll store. 
	Ultimate Fan : $15/month for ad-free access on up to six devices simultaneously, offline viewing, the Crunchyroll Game Vault, store discounts, free shipping, and exclusive swag after one year.

All Crunchyroll plans are paid on a month-to-month basis, and you can cancel at any time. Check out our guide on how to cancel a Crunchyroll membership for more details.  
Is there a Crunchyroll free trial for Premium memberships?
If you want to try Crunchyroll Premium for free , each plan offers a 14-day trial for first-time subscribers. Your subscription will automatically renew after your trial, but you can cancel anytime. 
Crunchyroll offers a free tier with limited access and ad support. It includes a rotating selection of titles that users can watch with or without a Premium plan. These can include a full series with multiple seasons or just a few episodes to whet your appetite. 
As of this writing, the list includes popular romance anime like "Ouran High School Host Club" and "My Dress-Up Darling."
You can access the Crunchyroll app on various devices, like your iPhone, Android smartphone, PlayStation, Xbox, Nintendo Switch, and Samsung smart TVs, as well as media players from Amazon, Apple, and Roku. You can check out the Crunchyroll site for a full list of supported devices.
Crunchyroll is known for its extensive library of anime titles, including series, movies, OVAs, and even music videos. It's also one of the few places you can watch anime the same day it releases in Japan, also known as simultaneous broadcasts or "simulcasts." 
From the season's latest hits to classic series, Crunchyroll has you covered. Here's a list of popular recent releases you can find on the service:
	"Bocchi the Rock!"
	"Chainsaw Man"
	"Demon Slayer: Kimetsu no Yaiba"
	"Jujutsu Kaisen"
	"Mashle: Magic and Muscles"
	"Mobile Suit Gundam the Witch from Mercury"
	"Ranking of Kings"
	"Spy x Family"
	"Zom 100: Bucket List of the Dead"

If you're looking to catch up on some older, must-watch series, Crunchyroll also has plenty of those. Here's some of what you can find there:
	"Cowboy Bebop"
	"Dragon Ball Z"
	"Fruits Basket"
	"Hunter x Hunter"
	"Lucky Star"
	"Naruto Shippuden"
	"One Piece"
	"Yu-Gi-Oh!"

Crunchyroll offers dubbed anime when available. Most new and popular series like "One Piece" and "Demon Slayer: Kimetsu no Yaiba" are available in dub, but some, like "My Love Story" and "Case Closed," are only available with subtitles and original Japanese audio.
Following Sony's acquisition of Crunchyroll in 2021, the streaming service is now merging with Funimation, an anime-only service also owned by Sony. The merger is already in action, with Funimation users being asked to sign in via Crunchyroll to combine their accounts. Nothing changes for new or existing Crunchyroll members.
Much of Funimation's anime library has already migrated to Crunchyroll, with more content set to migrate before the platform's official termination. Funimation is set to shut down its website and app on April 2. Though most of Funimation's subscription library will be available on Crunchyroll, Funimation users will lose access to their digital copy collections on that date. 
If you're a diehard anime fan searching for the most comprehensive service to subscribe to, Crunchyroll is what you're looking for. It's difficult to find the breadth and depth of coverage that this service has anywhere else, especially if you're a viewer not living in Japan. 
As a longtime fan, I especially enjoy how easy it is to find titles of every genre and age on Crunchyroll. Whether I feel like catching the latest "Gundam" series or need some nostalgic "Yu-Gi-Oh!" to play in the background, it's easy to find here. Gone are the days of having to find anime in multiple apps across the internet; now, it's all in one place for one monthly price. 
On the other hand, if you're more of a casual anime viewer looking to dabble in the medium every now and then, you may not need to sign up for a whole extra service. Some of the best streaming services that you may already be subscribed to, like Netflix , Amazon Prime Video , and Hulu , also have their own collections of anime that are probably enough to satisfy you. They even offer original exclusives that Crunchyroll doesn't, like Netflix's "Aggretsuko." I recommend looking into what other services have anime-wise because if you're already satisfied with that, you probably won't need Crunchyroll added to your monthly bills.
You can purchase logo and accolade licensing to this story here . Disclosure: Written and researched by the Insider Reviews team. We highlight products and services you might find interesting. If you buy them, we may get a small share of the revenue from the sale from our partners. We may receive products free of charge from manufacturers to test. This does not drive our decision as to whether or not a product is featured or recommended. We operate independently from our advertising team. We welcome your feedback. Email us at [email protected] .
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Say What? Chat With RTX Brings Custom Chatbot to NVIDIA RTX AI PCs
Chatbots are used by millions of people around the world every day, powered by NVIDIA GPU-based cloud servers. Now, these groundbreaking tools are coming to Windows PCs powered by NVIDIA RTX for local, fast, custom generative AI .
Chat with RTX , now free to download , is a tech demo that lets users personalize a chatbot with their own content, accelerated by a local NVIDIA GeForce RTX 30 Series GPU or higher with at least 8GB of video random access memory, or VRAM.
Ask Me Anything
Chat with RTX uses retrieval-augmented generation (RAG), NVIDIA TensorRT-LLM software and NVIDIA RTX acceleration to bring generative AI capabilities to local, GeForce-powered Windows PCs. Users can quickly, easily connect local files on a PC as a dataset to an open-source large language model like Mistral or Llama 2, enabling queries for quick, contextually relevant answers.

Rather than searching through notes or saved content, users can simply type queries. For example, one could ask, “What was the restaurant my partner recommended while in Las Vegas?” and Chat with RTX will scan local files the user points it to and provide the answer with context.
The tool supports various file formats, including .txt, .pdf, .doc/.docx and .xml. Point the application at the folder containing these files, and the tool will load them into its library in just seconds.
Users can also include information from YouTube videos and playlists. Adding a video URL to Chat with RTX allows users to integrate this knowledge into their chatbot for contextual queries. For example, ask for travel recommendations based on content from favorite influencer videos, or get quick tutorials and how-tos based on top educational resources.

Since Chat with RTX runs locally on Windows RTX PCs and workstations, the provided results are fast — and the user’s data stays on the device. Rather than relying on cloud-based LLM services, Chat with RTX lets users process sensitive data on a local PC without the need to share it with a third party or have an internet connection.
In addition to a GeForce RTX 30 Series GPU or higher with a minimum 8GB of VRAM, Chat with RTX requires Windows 10 or 11, and the latest NVIDIA GPU drivers.
Editor’s note: We have identified an issue in Chat with RTX that causes installation to fail when the user selects a different installation directory. This will be fixed in a future release. For the time being, users should use the default installation directory (“C:\Users\<username>\AppData\Local\NVIDIA\ChatWithRTX”).
Develop LLM-Based Applications With RTX
Chat with RTX shows the potential of accelerating LLMs with RTX GPUs. The app is built from the TensorRT-LLM RAG developer reference project, available on GitHub . Developers can use the reference project to develop and deploy their own RAG-based applications for RTX, accelerated by TensorRT-LLM. Learn more about building LLM-based applications .
Enter a generative AI-powered Windows app or plug-in to the NVIDIA Generative AI on NVIDIA RTX developer contest, running through Friday, Feb. 23, for a chance to win prizes such as a GeForce RTX 4090 GPU, a full, in-person conference pass to NVIDIA GTC and more.
Learn more about Chat with RTX .
NVIDIA websites use cookies to deliver and improve the website experience. See our cookie policy for further details on how we use cookies and how to change your cookie settings.

Free Download
Information Technology Business Plan Template
Download this free information technology business plan template, with pre-filled examples, to create your own plan..
Or plan with professional support in LivePlan. Save 50% today
Available formats:

What you get with this template
A complete business plan.
Text and financials are already filled out and ready for you to update.
	SBA-lender approved format

Your plan is formatted the way lenders and investors expect.
Edit to your needs
Download as a Word document and edit your business plan right away.
	Detailed instructions

Features clear and simple instructions from expert business plan writers.

All 100% free. We're here to help you succeed in business, no strings attached.
Get the most out of your business plan example
Follow these tips to quickly develop a working business plan from this sample.
1. Don't worry about finding an exact match
We have over 550 sample business plan templates . So, make sure the plan is a close match, but don't get hung up on the details.
Your business is unique and will differ from any example or template you come across. So, use this example as a starting point and customize it to your needs.
2. Remember it's just an example
Our sample business plans are examples of what one business owner did. That doesn't make them perfect or require you to cram your business idea to fit the plan structure.
Use the information, financials, and formatting for inspiration. It will speed up and guide the plan writing process.
3. Know why you're writing a business plan
To create a plan that fits your needs , you need to know what you intend to do with it.
Are you planning to use your plan to apply for a loan or pitch to investors? Then it's worth following the format from your chosen sample plan to ensure you cover all necessary information.
But, if you don't plan to share your plan with anyone outside of your business—you likely don't need everything.
A faster way to plan.
LivePlan is the #1 planning tool for over 1 million businesses.

More business planning resources

How to Start a Business With No Money

How to Write a Business Plan for Investors

Simple Business Plan Outline

How to Write a Business Plan

Industry Business Planning Guides

10 Qualities of a Good Business Plan

Business Plan Template

How to Create a Business Plan Presentation
Download your template now
Need to validate your idea, secure funding, or grow your business this template is for you..
	Fill-in-the-blank simplicity
	Expert tips & tricks

We care about your privacy. See our privacy policy .
Not ready to download right now? We'll email you the link so you can download it whenever you're ready.
Download as Docx
Download as PDF

Finish your business plan with confidence
Step-by-step guidance and world-class support from the #1 business planning software

Discover the world’s #1 plan building software

We've detected unusual activity from your computer network
To continue, please click the box below to let us know you're not a robot.
Why did this happen?
Please make sure your browser supports JavaScript and cookies and that you are not blocking them from loading. For more information you can review our Terms of Service and Cookie Policy .
For inquiries related to this message please contact our support team and provide the reference ID below.
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	Tech Support Business Plan Template & Guidebook
Business plans 15 min read Tech Support Business Plan Template & Guidebook If you're looking to start a successful tech support business, you've come to the right place! The #1 Tech Support Business Plan Template & Guidebook provides an easy-to-follow roadmap that outlines exactly what you need to do to create a professional and comprehensive plan.




	8 free IT strategic planning templates and examples for CIOs
Step 1. Know how you succeed. Step 2. Understand your differentiators. Step 3. Develop a rich story from a specific viewpoint. Step 4. Draw a picture to commit your strategy to paper. The details on translating your strategy story into a strategic plan are spelled out in this downloadable PDF.




	IT Company Business Plan Template & How-To Guide [Updated 2024]
Your IT business plan is a living document that should be updated annually as your company grows and changes. With regards to funding, the main sources of funding for an IT business are personal savings, credit cards, bank loans, and angel investors.




	IT & Tech Support Business Plan Examples
Not sure where to start? Check out our library sample business plans to ensure your IT business can support clients for years to come. If you're looking to develop a more modern business plan, we recommend you try LivePlan.




	Information Technology Business Plan Example
2.2 Start-up Summary. Our start-up costs will be $1M, which includes $450,000 for the acquisition of the Maui and Hilo operations of Servco Integrated Office Technology. The remainder of the funds will be used for: Initial Inventory: $200,000. Initial Capitalization: $225,000.




	Computer Support Business Plan Example
Computer Support Business Plan Start your own computer support business plan I Tech Solutions Executive Summary I Tech Solutions is a consulting-oriented company, intending to fill in the market need for a professional, customer-focused computer company.




	Free Startup Business Plan Templates
Get free Smartsheet templates. In this article, we've rounded up a variety of the top, professionally designed startup business plan templates, all of which are free to download in PDF, Word, and Excel formats. Included on this page, you'll find a one-page startup business plan template, a business plan outline template for startups, a ...




	Technology Business Plan Template & How-To Guide [Updated 2024]
Written by Dave Lavinsky Technology Business Plan Template Over the past 20+ years, we have helped over 1,000 entrepreneurs and business owners create business plans to start and grow their technology businesses. On this page, we will first give you some background information with regards to the importance of business planning.




	Free PDF Business Plan Templates
Strategic planning Free PDF Business Plan Templates and Samples Get free Smartsheet templates By Joe Weller | September 9, 2020 We've gathered the most useful collection of business plan PDF templates and samples, including options for organizations of any size and type.




	Remote Tech Support Business Plan [Sample Template]
By: Tony Martins Ajaero Home » Business Plans » Technology Sector Are you about starting a tech support company? If YES, here is a detailed sample remote tech support business plan template & feasibility report you can use for FREE. In today's world, computers are a standard part of every family and a major tool used by businesses.




	Technology Business Plan Template (2024)
Below is a Technology business plan template and sample to help you create each section of your own business plan. Executive Summary Business Overview




	5+ Technology Business Plan Templates
What exactly goes into an Information Technology Business Plan Sample? A far cry from a Farm Business Plan, An information tech business plan is going to include consulting factors, new or used computers, wiring for high-speed internet, a tech support base, and more. Outline your initial needs before securing the services of the consultant.




	7 Steps to Create a Technology Startup Business Plan
By including the seven elements below, you'll have a plan that gives your company a much stronger footing. 1. Executive Summary. The executive summary is, without a doubt, the most critical element of your tech startup business plan. Despite this, a lot of plans fail here because the summary doesn't captivate readers.




	Create a Tech Startup Business Plan: 199+ Business Plan Templates
Businesses, by Swati Maheshwari Create a Tech Startup Business Plan: 199 Resources for Business Plan Templates and Examples Having a great business idea and having the willingness and ability to jump into the entrepreneurial or intrapreneurial journey are the stepping stones to a successful journey.




	PDF Business Plan Guideline for Small and Medium Scale Enterprises
2.1 The Objectives of a Business Plan. There are two primary purposes for preparing a business plan. The first is external, to secure funding that is very important for the growth and development of the enterprise. The second is internal, which is to support the strategic and corporate development of the business.




	PDF Startup Guide
technology. • Funding: Availability of capital to build and grow the business, together with the interest, capabilities, and track record of likely investors. • Commitment: Level of commitment and involvement of the inventors. • Support: Presence of a true business champion for both the technology and the new venture.




	Technology Solutions Business Plan Sample 2024
2.1 The Business. MacArthur Tech Services will be a licensed and register tech services provider in Detroit. It will be owned by Maximilien MacArthur who is a former executive from Silicon Valley and has worked for many tech startups. This business plan for tech startup will help you learn from MacArthur's experience.




	5+ Tech Startup Business Plan Templates
Writing The Tech Startup Business Plan. The writing part of the tech startup business plan is an essential process a business owner should take note of. Everything should be specific and detailed. Here are the steps in writing the business plan: 1. Start with the cover page. The cover page of the business plan should contain the title, name and ...




	PDF PREPARING A TECHNOLOGY BUSINESS PLAN
PREPARING A TECHNOLOGY BUSINESS PLAN CASE 1 : NEW MATERIALS BUSINESS PLAN FOR HEPHAESTUS MATERIALS LTD Hephaestus Materials Ltd 48 Britannia Road Little Blighty-on-the Wold London UK Tel.: 171-8285036 Fax: 171-8289318 Key Contacts: Dr Erebus Technical Director Mr U. Heep Finance Director




	Technology Business Plan Examples
Explore our library of Technology Business Plan Templates and find inspiration for your own business. Business Planning. ... computer support, I.T., computer engineering, and a number of other potential businesses. If you're looking to develop a more modern business plan, we recommend you try LivePlan. It contains the same templates and ...




	30 Emerging Technologies That Will Guide Your Business Decisions
Identify relevant emerging technologies and business benefits that support your strategic product roadmap Download Now: The Tech Product Leader's Guide to Emerging Technologies and Trends Each of the 30 technologies and trends on the impact radar falls into one of four themes: smart world, productivity revolution, privacy and transparency, or ...




	(PDF) Sample Technology Business Plan
(PDF) Sample Technology Business Plan | Wanda Halpert - Academia.edu Download Free PDF Sample Technology Business Plan Wanda Halpert Wanda Halpert prepared a business plan for a technology company. You may see a sample in the link below. See Full PDF Download PDF Related Papers




	Sam Altman Seeks Trillions of Dollars to Reshape Business of Chips and
The OpenAI chief executive is pursuing investors including the U.A.E. for a project possibly requiring as much as $7 trillion.




	Create a form in Word that users can complete or print
Show the Developer tab. If the developer tab isn't displayed in the ribbon, see Show the Developer tab.. Open a template or use a blank document. To create a form in Word that others can fill out, start with a template or document and add content controls.




	(DOC) IT Support BUSINESS PLAN
Chabeli Seele Uni-tech Solutions is a consulting-oriented company, intending to fill in the market need for a professional, customer-focused IT company. The company emphasizes service and support to differentiate itself from more price-oriented computer companies. We are on the brink of penetrating a lucrative market in a rapidly growing industry.




	What Is Crunchyroll? the Anime Streaming Service, Explained
Crunchyroll offers a free tier with limited access and ad support. It includes a rotating selection of titles that users can watch with or without a Premium plan.




	Chat with RTX Now Free to Download
Chatbots are used by millions of people around the world every day, powered by NVIDIA GPU-based cloud servers. Now, these groundbreaking tools are coming to Windows PCs powered by NVIDIA RTX for local, fast, custom generative AI.. Chat with RTX, now free to download, is a tech demo that lets users personalize a chatbot with their own content, accelerated by a local NVIDIA GeForce RTX 30 Series ...




	Free Information Technology Business Plan Template + Example
Download a free information technology business plan template in PDF or Word doc format What you'll get with this template: A complete business plan Unlike other blank templates, our business plan examples are complete business plans with all of the text and financial forecasts already filled out.




	Cisco Plans to Cut Thousands of Jobs After Sales Growth Stalls
Cisco Systems Inc., the largest maker of networking equipment, plans to cut thousands of jobs after a slowdown in corporate tech spending wiped out its sales growth. A restructuring plan will ...
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